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Welcome To Nuance
Multi-label Imaging Without Cross-talk
As biological imaging becomes more about studying complex
systems rather than single events, Nuance multispectral imaging
systems let you quantitate multiple molecular markers even when
they are co-localized in a single tissue section, producing clear
and accurate images of each individual label on a multi-label
tissue section.
The unique and patented Real Component Analysis (RCA) tool
automatically detects spectral components. View and quantitate
signals as either single images, as overlays, or as a composite
image showing all unmixed labels in high contrast. Nuance
systems offer powerful spectral unmixing capability to remove
autofluorescence, thereby dramatically increasing signal-to-noise
and improving the accuracy of your results.

Getting Started — New Users
Review the Introduction to Multispectral Imaging Theory and Concepts
with the concepts behind multispectral imaging technologies.

7

to familiarize yourself

Study the Getting Started with Nuance 17 section to familiarize yourself with the Nuance
Hardware components and the software.
Make sure you review the Method Development
accurate and reliable spectral libraries.

31

section, which discusses methods for building

You might also find it helpful to run through the Practice Exercise
spectrally unmix a counterstain from a target-specific marker.

37

to see how easy it is to

If desired, see the Practical Multiple Staining Pamphlet on the installation CD for a discussion on
staining and imaging.
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Introduction to Multispectral Imaging
This section provides an introduction to the theory and concepts that enable PerkinElmer's multispectral
imaging systems to function as well as they do.

2.1

Light
Light, as used in this discussion, means the portion of the electromagnetic spectrum that is visible
to the human eye. While the physical description of light can be highly complex, we will restrict this
discussion to the wavelengths of light, and the interaction of that light with physical and biological
materials.
The Electromagnetic Spectrum is illustrated in the figure below from radio to gamma ray
frequencies. We are concerned with the visible wavelength range for purposes of this discussion,
although the Nuance imaging system can operate out to 950 nm, into the so-called near-infrared
wavelength range.

Figure 1: The Electromagnetic Spectrum

Although this illustration of the electromagnetic spectrum(1) suggests that the visible range of light
covers approximately 400 nm to 800 nm, most humans realistically are limited to the range of 400
nm (deep violet) to 700 nm (deep red). Visible light makes up a very small portion of the entire
electromagnetic spectrum.
Light is the transmission of energy. Visible light is associated with an energy level of about one
electron volt per photon. As one moves to shorter wavelengths of light, the energy per photon
increases. In the shorter ultraviolet wavelengths, which approach soft x-rays, the electron energy per
photon increases to 50 to 100 electron volts. This energy content of light is useful when one wishes
to induce a change of energy state in a material (i.e., cause a receptive molecule to undergo a
series of energy additions and then relaxations, resulting in fluorescence).
(1) The Electromagnetic Spectrum illustration was prepared by NASA under Contract NAS5-26555 f or the Education Group of the Space
Telescope Science Institute’s Of f ice of Public Outreach. It is used here under public domain in accordance with NASA’s contract.
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2.2

Human Perception of Light Intensity and of Color
A Highly Adaptive Light Detector
The human eye is a highly adaptive light detector, becoming significantly more sensitive in low light,
and less sensitive under bright light. This adaptive change is not instantaneous, and it takes some
time for the eye to fully adjust to a new illumination level. This is the reason one needs to “dark
adapt” by being in a darkened room for some time before observing weak fluorescence through a
microscope.
While the eye can be very sensitive to low light levels and can also “see” in very bright conditions, it
does not discriminate light levels very well. An individual has no “internal meter” that indicates the
current sensitivity level setting for the eye. The eye also has a limited ability to discriminate levels of
illumination ranging from the lowest level to the highest level at any given sensitivity. US Department
of Defense research indicates that while some people can distinguish as many as 500 levels of gray,
most humans can only distinguish approximately 30 to 35 levels of gray, ranging from black to
white. This is relatively insensitive to the actual total illumination level, although the ability to
discriminate gray levels does degrade in both very dim light and very bright light.

Response to Illumination
The eye’s response to illumination is not a linear response, but more closely approximates a
logarithmic function. The result is that while the human eye interprets differences between gray
levels as “even steps,” to achieve a two-fold brightening of the perceived gray level, the actual
illumination level would need to increase significantly more than a simple doubling.
Contrasting the eye with a digital electronic sensor system, any sensor that has 8-bit resolution can
detect 256 levels of gray. As the number of bits of resolution increase, the number of gray levels also
increases. A 10-bit system gives 1024 levels and 12 bits yields 4096 levels of gray. Digital electronic
sensors are linear in response to light levels.

Ability to Distinguish Colors
While the eye is relatively poor at discriminating gray levels (intensity), it is very good at
distinguishing colors. Most individuals are estimated to be able to discriminate thousands of colors.
The problem is, no two individuals see precisely the same color. In other words, each individual
interprets colors slightly differently when viewing the same color. The basis for this is the way in
which color sensors are arranged in the eye.
The eye contains three different types of color sensors, similar in response to the red, green and
blue detectors in color cameras. Individual colors are composed of some combination of responses
from these three different types of color sensors. While the general arrangement of these color
sensors (cone cells) in the eye is reasonably standard, there are differences in the total number of
each type of cone cell, and in the actual physical arrangement within the detecting cell layer (retina).
These minor variations lead to the differences in perceived color between individuals, as does the
actual way in which the individual’s brain learned to interpret color(s).

8
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2.3

Light Absorbance and Reflection
We perceive objects based on the way they interact with incident light (excepting light emitting
objects such as light sources, and fluorescing or phosphorescing objects). Objects transmit,
absorb, and/or reflect light; in most cases they exhibit a combination of transmittance,
absorbance, and, reflection. The perceived color of a non-transmissive object is a direct result of
both absorbance and reflection of light. An opaque object we would perceive as red is one that
absorbs most wavelengths of light, except for red wavelengths that are reflected back to the eyes of
the observer. An object we would perceive as red in transmission is one that transmits primarily red
wavelengths, while absorbing or reflecting other wavelengths.
Generally speaking, absorbance and reflection of light are very similar phenomena. One can say that
the light transmitted through a semitransparent object is the light that is not absorbed by the object.
Note how similar this is to the definition of reflectance. Only the geometry is different. Reflectance is
more complex than simple transmission due to variations in surface texture, transparency of the
reflecting layers, and the characteristics of the opaque surface beneath the reflecting layers.
In brightfield light microscopy we have a controlled geometry, and are observing light that is
transmitted through a specimen. Excepting a few pigments and inclusions, biological specimens are
essentially invisible, unless we employ some absorbing dye, or specific optical arrangement to
impart contrast. It is this need for contrast that led to the initial development of biological stains and
stain protocols and subsequently to phase contrast and other optical contrast enhancing
techniques.
The amount of light absorbed by a dye or stain in a specimen can provide a measurement of the
amount of the absorbing material present. This is the basis of spectrophotometry. A basic law of
spectrophotometry is the Beer-Lambert law, which states that the amount of material present
(absorbance) is defined by the relationship:
Absorbance = -log(transmission) = (molar absorbtivity) x (path length) x (concentration)
For a given material, the molar absorbtivity, also called the molar extinction, is a constant, and
therefore one only needs to determine the percent transmission of light through the specimen and
the path length in order to calculate the concentration. The transmission is the amount of light
without the specimen versus the amount of light with the specimen, and this is easily measured.
Since transmission is based on a ratio, it is not sensitive to actual light level, assuming that the light
does not change between the measurement of the “blank” or 100% level; and the “specimen” or
sample measurement. It is this basic law that is used in solution spectrophotometry to determine
the concentration of absorbing materials in solution.
The Beer-Lambert law has two specific requirements:
The absorbing material must be homogeneous
The absorbing material must be a true absorber of light, not a light scatterer
This first requirement poses problems for spectrophotometry through a microscope. The very reason
one uses a dye on a microscope preparation is to see structure, and by definition, if one can see
structure, then the dyed material is not homogeneous. While this may seem like an insurmountable
obstacle to performing spectrophotometry through a microscope, the solution is simple. Microscope
optics are characterized by their ability to resolve two points as separate. This is the resolution of a
particular lens system. If the light detector element sees a smaller portion of the specimen than the
lens system can resolve as separate points, then by definition, the spot being measured is
homogeneous.
Using modern CCD or CMOS cameras for image collection, accurate spectrophotometry requires
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that each individual pixel of the sensor see a portion of the specimen that is smaller than the lens
resolution of the particular lens system being used. In practical terms, this means the camera pixels
should be smaller than:
(magnification) x 1.22 x (wavelength) ÷ (NAobjective + NAcondenser)
The result of not having homogeneity of absorption at each pixel is an error called distributional
error. Distributional error can be accurately defined mathematically, but the following illustration will
suffice to understand this principle. Assume you have a light shining through an aquarium filled with
water and some means of measuring the amount of light coming through the aquarium. If you place
a small-capped bottle of ink into the aquarium, the measured amount of light will decrease by only a
small amount. If you reach into the aquarium and remove the cap from the ink bottle and let the ink
diffuse throughout the aquarium, the measured amount of light will decrease significantly. The total
amount of ink in the aquarium is the same in both cases; it is only the distribution of the ink that is
different. In practical microscope systems, distributional error can give errors of up to 40% if the
specimen is not homogeneous at the detector element(s).
The second requirement of the Beer-Lambert law is that the material being measured must be a true
absorber, and not a light scatterer. There are several reasons for this. One is that we cannot
determine a molar extinction (the “constant” in the Beer-Lambert equation) for a sample with mixed
properties. A more understandable rationale is based on the microscope optics. If a material
scatters light, as the concentration of the material increases, more light is scattered, and this
scatter can be outside the capture cone of the objective being used. Obviously, any light that is
scattered in such a way as to not be seen by the objective cannot be measured. The consequence
of this is that the detected signal is non-linear as the concentration of the mixed absorber-scatterer
changes.
Assuming a specimen with a true absorbing chromogen, and an appropriate magnification for the
detector being used, the Beer-Lambert law provides for true brightfield microscopy quantitation. After
an image is converted to optical density or absorbance, each pixel is a true measure of light
transmission at that pixel. This is because the background illumination is taken into account in the
conversion. Absorbance images are therefore not constrained by total illumination level, and if the
same specimen is imaged through identical optical systems at two different illumination levels, the
resulting absorbance images should be identical.
There are several requirements that need to be met to achieve the accuracy inherent in optical
density or absorbance measurements. It is necessary that the illumination be even over the entire
image field. For microscope systems, this may not be the case, if the microscope illumination
system is not carefully aligned.
Accurate measurements depend on some mechanism to perform a “flat field correction” for
illumination inconsistencies. A common way to do this is to collect an image of the illumination field
with no specimen in place (a blank field image). To ensure accurate data, any quantitative system
should be able to meet the “test of the five positions”. This involves selecting some object in a field of
view, and then taking images of this object when placed in the center of the image field, and when
placed at the top, bottom, left and right of the image field. In each of these five positions, the object
should yield identical measurement results.

2.4

Fluorescence
Many biological and natural materials give off light of a particular color when exposed to light of
another color. This property is a type of luminescence. If the emitted light occurs rapidly after
illumination (around one-millionth of a second), the luminescence is called fluorescence. If the light
emission takes longer than one-millionth of a second, the luminescence is called
phosphorescence. Materials that exhibit fluorescence have proven extremely useful as labels or
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indicators in many biological systems.
Fluorescence light emission is different than light absorption. Each fluorescent molecule generates
light. We measure the total amount of light generated, and are not dependent on the interaction of
the light with another material, such as a dye. While it would seem that fluorescence is much more
amenable to accurate measurement than absorbed light, there are a number of factors that
complicate such measurements. Fluorescence is emitted by a molecule in all directions, and most
imaging systems are designed to capture light coming from a particular direction only. Therefore,
there is no way to capture all of the light emitted by a fluorescent molecule with such a system.
Additionally, fluorescence emission is influenced by the local environment, in particular by pH. The
total amount of fluorescence will therefore depend on these local conditions of pH, as well as other
surrounding molecules that may either enhance or quench some of the fluorescence energy. There
is also the problem of obtaining identical excitation of all fluorescence molecules in a specimen, and
this can be exceedingly difficult to achieve.
Fluorescence is an extremely sensitive technique, as it is much easier to visually assess or
measure light emission against a dark background than it is to see a decrease in light intensity from
absorption by a dye. Regardless of the sensitivity of fluorescence, the difficulty in establishing
uniform excitation, and controlling for local environment effects makes quantitation of fluorescence
emission difficult in biological preparations.

Stoke’s Shift
Materials that fluoresce always emit light at a longer wavelength than the wavelength of the exciting
light. As an example, rhodamine isothiocyanate can be excited by green light, and then emits red
light. This difference between the wavelength of the exciting light and the emitted light is called the
Stoke’s Shift and is based on Stoke’s Law.
A range of excitation wavelengths will excite fluorescence. This range of wavelengths is known as
the absorption spectrum. The emitted light also covers a range of wavelengths, and this is known
as the emission spectrum. Since the Stoke’s Shift for most materials is not that great, there is
generally some overlap between the excitation and the emission spectra. We will return to this point
shortly as it does impact choice of emission and excitation filters in fluorescence systems. This
figure contains an example excitation and emission spectra, showing Stoke’s Shift and the overlap
of the spectra.

Figure 2: Stoke's Shift

Introduction to Multispectral Imaging
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Autofluorescence
Many biological materials are naturally fluorescent. In particular, many vitamins, some hormones,
and a variety of biological enzymes and structural proteins are naturally fluorescent. These materials
often fluoresce strongly enough to interfere with specific fluorescence labeling studies. Because of
this unwanted background, or autofluorescence, both excitation light sources and emitted light
paths are highly filtered in fluorescence systems.
On continued stimulation (illumination at the excitation wavelength), most fluorescent materials fade.
While some specific preparation methods can reduce the rate of fading, and different fluorescent
materials fade at different rates, all fluorescent materials eventually fade, and this effect is
irreversible. For this reason, specimens should be illuminated only while aligning and focusing, and
during actual image collection. At other times, the excitation light should be closed off.

Excitation and Emission Filters
Filters that are used for fluorescence excitation and emission are specifically constructed to have
very narrow pass bands. They pass only a limited range of wavelengths of light. Restricting the
excitation light wavelengths may reduce the amount of autofluorescence. Restricting the wavelength
range of the emitted light helps minimize the amount of autofluorescence light that interferes with
observing and measuring the desired specific fluorescence.

Figure 3: Excitation Filter Types

Excitation filters should be chosen to match the excitation maximum of the fluorescence label being
used. The emission filter should match the emission maximum. In practical terms, the filter maxima
may be slightly different from the ideal case, simply due to limitations of filter manufacturing, or to
assist with autofluorescence reduction.
Specific excitation and emission filter combinations are available for most commonly used
fluorescence dyes or labels. Nevertheless, regardless of how carefully one matches the excitation
and emission filters to a given label, there will be some background autofluorescence, and this will
reduce the perceived contrast between the “real” or actual label fluorescence and the specimen
background.

2.5

The Multispectral Solution
The Nuance imaging system offers a unique solution to the problem of autofluorescence and
selection of emission filters. Multispectral analysis is based on the fact that all fluorescent materials
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produce a unique spectral emission. In other words, if you excite a material, and then examine the
emitted fluorescence over a range of wavelengths, and record the intensity of emission at each point
along the plotted curve of those wavelengths, you can generate an “emission spectrum” (like the
green emission spectrum shown in the figure illustrating Stokes Law 11 ). This spectrum is different
for each specific fluorescent material.

Overlapping Emission Spectra
The complication is that for many fluorescent labels of biological interest, the emission spectra
overlap significantly, and these emission spectra may also be obscured by autofluorescence from
other constituents of the specimen. Often, autofluorescence is a strong (bright) broad signal that
may obscure the specific fluorescence that the investigator wishes to see.

Figure 4: Overlapping Excitation and Emission Spectra

In this example of overlapping excitation and emission spectra, green is MitoTracker® Green Fn,
Blue is Acridine Orange, and Red is Fluorescein isothiocyanate (FITC). The Cyan line at 488
represents the illumination light. Dotted lines are excitation spectra, and solid lines are emission
spectra. (Illustration derived from Invitrogen™ Spectraviewer.)
There are three points to note in the graph shown above.
1. The excitation spectra overlap significantly with the emission spectra. This is why one needs to
carefully select excitation filters. The goal is to prevent as much excitation light as possible from
appearing in the emission spectra.
2. Even with distinct emission spectra, there is significant overlap in the emission spectra of these
three dyes. Visual examination of such a mixture of fluorescence spectra would be unable to
distinguish these three dyes as individual “colors.” They would be seen as some combination of
yellow and green by most observers.
3. The graphical display of spectra is normalized, and in actual practice, some fluorescent
materials are much brighter than others.
As the graph illustrates, many labels of biological interest have emission spectra that are so similar
that separation using narrow band filters is difficult or impossible. Multispectral analysis provides the
solution to this problem and reduces the need for multiple expensive narrow-band emission filters. A
single long-pass emission filter can replace a large collection of emission filters.

Introduction to Multispectral Imaging
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Multispectral Analysis
Multispectral analysis generates the spectral curves for the various fluorescent dyes or materials in
a specimen. In addition, it generates a spectral curve for the autofluorescence that almost always is
present to some degree. Using sophisticated algorithms, the contribution of autofluorescence to the
image can be removed, and the individual fluorescence spectra separated. The result is a set of
images representing each spectrum that contributes to the final image.
In other words, as illustrated in the graph above, multispectral analysis yields (1) an
autofluorescence image, (2) a MitoTracker Image, (3) a Acridine Orange image, and (4) a FITC
image. By removing the autofluorescence contribution to the image, the actual signals from the
applied labels (MitoTracker, Acridine Orange and FITC) can be readily seen. If these individual
images are recombined using highly contrasting colors to represent the location of each of the
labels, a composite image of high contrast and readily observable colors can be generated.

The Nuance Imaging System
The Nuance imaging system’s combination of unique hardware and sophisticated software makes
powerful multispectral analysis possible. In a multispectral analysis, a series of images is captured
at specific wavelengths. The range of wavelengths captured should cover the spectral emission
range of the labels present in the specimen. The number of images within that range should be
chosen to adequately define the emission spectral curve for each label. The result will be a series of
images, called an “image cube,” taken at specific wavelengths. The data within the image cube is
used to define the individual spectra of both autofluorescence and specific labels.

Figure 5: Mouse Intestine with Five Unmixed Fluorescent Elements

This figure shows a specimen (courtesy of Molecular Probes, Inc.) with poor contrast between the
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five different fluorescent elements. A conventional color image is shown in the upper left. By
acquiring a multispectral data cube and using the Nuance system’s unmixing tools, a new
Composite Unmixed Image can be created (shown on the right). Separate grayscale images
representing each unmixed component are also created.
As the figure illustrates, many labels of biological interest have emission spectra that are so similar
that separation using narrow band filters would be difficult or impossible. Multispectral analysis
provides the solution to this problem, and in addition reduces the need for multiple, expensive and
very narrow band emission filters. A single long pass emission filter can replace a large collection of
emission filters. Multispectral analysis is able to separate all of these autofluorescence signals from
the specific labels applied to the specimen, and provides the ability to localize each material
present, and to detect weak specific labeling even in the presence of strong autofluorescence.

2.6

Nuance FLEX Multispectral Imaging
Nuance FX and EX imaging systems have the unique ability to narrow the bandwidth of the Liquid
Crystal Tunable Filter by half. Flex technology lets you use the system in broad or narrow mode,
which greatly increases the system’s multiplexing capabilities for brightfield and fluorescence
imaging. This figure shows LCTF transmission with and without Flex technology at 700 nm and 800
nm.

Figure 6: Comparison of LCTF transmission with and without FLEX

Use the system in narrow mode to obtain better resolution of closely spaced and overlapping
emission spectra. Narrow mode can also increase the number of detectable chromogens or
fluorophores in your sample with overlapping spectra. This can increase the dynamic range of your
multiplexed signals. This figure illustrates the higher spectral resolution obtained with Flex
technology.

Introduction to Multispectral Imaging
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Figure 7: Comparison of 605 nm Qdot™ with and without FLEX
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Getting Started with Nuance
PerkinElmer’s Nuance multispectral imaging systems are high-performance multispectral imaging
systems that can be installed on an upright or inverted microscope's C-mount camera port, on a copy
stand, or on a camera tripod for field use. Properly configured Nuance systems can be used for
applications as diverse as biomedical research, materials QA/QC, forensic analysis, and archeology.
(Nuance systems are not intended for clinical or diagnostic use at this time.)
The patented liquid crystal (LC) tuning element functions as a high-quality interference filter that enables
the transmitted light to be electronically tunable. This allows rapid, vibrationless selection of wavelengths
in the visible or NIR range, and digital images (called image cubes) are captured at the specified
wavelengths. The intuitive Nuance acquisition and analysis software performs spectral classification and
unmixing of overlapping dyes or stains that may look indistinguishable to the naked eye but have
differing spectral signatures.
The Nuance product family includes one general purpose model and two fluorescence-optimized models:
The Nuance VX for visible wavelengths operates on or off the microscope in the wavelength
range of 420-720 nm.
The Nuance FX and Nuance EX operate on or off the microscope in either the 420-720 nm range
(FX) or the 450-950 nm range (EX) and have electronically selectable bandwidths.
The topics in this section provide an introduction to the Nuance multispectral imaging system. This
section includes a brief description of each of the system’s hardware components and software
features.

3.1

Operator and Equipment Safety
It is the responsibility of the purchaser to ensure that all persons who will operate the imaging system
are aware of the following cautionary statements. As with any scientific instrument, there are important
safety considerations, which are highlighted throughout this User’s Manual.

General Cautionary Statements
READ AND UNDERSTAND THIS USER’S MANUAL BEFORE ATTEMPTING TO
OPERATE, TROUBLESHOOT, OR MAINTAIN THE NUANCE IMAGING SYSTEM.
READING THIS MANUAL FIRST MAKES IT EASIER AND SAFER TO OPERATE AND
MAINTAIN THE SYSTEM.
Operate the system on a flat, stable surface.
Do not drop the imaging module.
Do not expose the imaging system to prolonged heat above 40 °C.
Do not operate the system in an environment with explosive or flammable gases.
Do not subject the imaging system or its components to intense light from laser, focused arc or Hg
lamp sources.
Do not operate the system in places where it may be splashed with liquid.
Use only a properly grounded power cable appropriate for the site where the system is installed.
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Some cables and adapters supplied with the system have proprietary specifications. Do not connect
components supplied by PerkinElmer using unqualified cables or adapters. Doing so could result in
damage, and voids the Warranty.
Use only a properly grounded power outlet when connecting the system to power.
If you are using third-party mechanical components for the Nuance system, consult the System
Specifications & Dimensions 104 topic.
Clean the Nuance imaging system periodically. This will help ensure optimal performance over years
of use. See Cleaning the Nuance Imaging Module 21 .
Caution: Service should be performed by PerkinElmer authorized and trained personnel only. Power
must be disconnected from the system before servicing.

For Technical Assistance
If you experience any difficulty setting up, operating, or maintaining your imaging system, please
refer to the Troubleshooting 102 section of this documentation. If that does not resolve your problem,
contact your PerkinElmer representative. Office hours are 8:00 a.m. to 8:00 p.m. (Eastern Standard/
Daylight Time), Monday through Friday.
Telephone: 800-762-4000 or +1 203-925-4602
Fax: +1 203-944-4904
E-Mail: global.techsupport@perkinelmer.com

3.2

About this Manual
This manual describes the use and functionality of the Nuance multispectral imaging system and the
Nuance version 3.0.2 software. Operating instructions, functional descriptions, troubleshooting,
illustrations, and other relevant information are contained in this manual.

Design Change Disclaimer
Due to design changes and product improvements, information in this manual is subject to change
without notice. PerkinElmer reserves the right to change product design at any time without notice
to anyone, which may subsequently affect the content of this manual. PerkinElmer will make every
reasonable effort to ensure that this User’s Manual is up to date and corresponds with the shipped
Nuance multispectral imaging system.

Reproduction Disclaimer
This User’s Manual is solely for the use of the owner and operator of the PerkinElmer Nuance
multispectral imaging system. Any reproduction of this publication in part or in whole without the
express written consent of PerkinElmer is strictly prohibited. Neither may this publication be made
available for electronic download without the express written consent of PerkinElmer.
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Help Menu in the Nuance software
The Help menu in the Nuance software provides quick access to the Nuance Help Topics. You can
also view the Filter Selection Guide and the Quick Start Guide, both in PDF format. The Help >
About menu item displays the current Nuance software version number as well as other important
system information.

3.3

CE, CSA, and UL Testing and Certification
The Nuance multispectral imaging system has been tested by an independent CE
testing facility, and bears the appropriate CE mark.

The Nuance system has been awarded the right to display the CSA mark.

The Nuance system has undergone tests to meet UL standards.
For more information, contact PerkinElmer.

3.4

Nuance Imaging Module
The Nuance Imaging Module contains all of the principal imaging components in a single compact
enclosure:
High-resolution, scientific-grade CCD imaging sensor
Solid-state liquid crystal (LC) wavelength tuning element
Spectrally optimized lens and internal optics
Industry-standard C-mount (compatible with 1x C-mount camera tube)
Industry-standard threaded mounting hole for securing the module to a camera tripod or other
holder.
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Figure 8: Nuance Imaging Module (front view)
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Figure 9: Nuance Imaging Module (rear view)

Workstation Computer
Nuance multispectral imaging systems require a computer with a level of performance appropriate for
acquiring and analyzing digital multispectral data. Computers purchased from PerkinElmer that will
be used with the Nuance system meet the performance requirements listed in System
Specifications and Dimensions 104 If you decide to supply your own computer, be sure it meets the
performance requirements as well.

Cleaning the Nuance Imaging Module
It may be necessary to periodically clean the outside of your Nuance imaging module. Follow these
guidelines when cleaning:
Spray a clean cloth with a cleaning solution such as 70% ethanol and wipe down the external
surfaces of the imaging module.
If dust particles are present on the optics, use a blow-off gun connected to clean dry nitrogen to
blow dust away. Using canned air is not recommended due to the risk of spraying liquid
compressant onto the optics, which will damage optical coatings.
Do not touch optical surfaces with your fingers. Oils may damage sensitive coatings.
If optical surfaces require more thorough cleaning, apply lens-cleaning fluid, spectroscopic-grade
isopropyl alcohol, distilled water, or methanol to a lint-free lens tissue and drag-wipe the surface.
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Do not rub the surface because anti-reflection coatings can be scratched. If further cleaning is
required, repeat with a fresh tissue and fluid after one pass, since contaminants need to be
wicked away, not spread over the optical surface.

Powering Up the Imaging Module
Connect the power cable to the imaging module and plug it in to a surge protected electrical
outlet.
Connect the USB cable to the Nuance imaging module and the workstation computer.
Blinking LEDs on the front of the unit indicate initialization is in progress. When the STATUS LED
illuminates steady green, initialization is complete and the imaging module is ready.

3.5

Installing & Starting Nuance
The Nuance software requires an activated license number to run. If you already purchased the Nuance
system with a computer, your software was installed and activated for you at the factory. To start
Nuance, select Start > All Programs > PerkinElmer > Nuance > Nuance 3.0.2. Or double-click the
Nuance icon on the desktop.
If you need to install and/or activate the Nuance software, refer to the separate Nuance System Setup &
Installation card.
Power up the Nuance imaging module. (You can run the Nuance software without a connection between
the computer and the Nuance imaging module. However, you will not be able to acquire images unless it
is connected.)

Evaluating Nuance Software
If you have not yet purchased a Nuance system but you want to evaluate the software, select the
Get Trial option when the Software Activation Required dialog box opens. You will be allowed to
use the software for 30 days before being required to purchase and activate the software to continue
using it.

Recovering a Lost Seat License
Nuance seat licenses are not transferable or recoverable. If your seat license is damaged or
inadvertently destroyed, please contact PerkinElmer for a replacement license.
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3.6

Understanding the Nuance Work Area
The Nuance work area includes a menu bar, a toolbar, control panels for acquiring and analyzing
images, an image gallery, and thumbnails and data pages. This figure shows a sample of the work area
with a cube and a set of unmixed images.

Figure 10: Nuance Work Area

A. Toolbar
The toolbar makes it easy to access a variety of functions including loading and saving cubes,
adjusting the image zoom level, drawing measurement regions, and adjusting the display settings.
The tools that are available on the toolbar will change based on the current action.
Click this button or select Open Cube from the File menu to open an image cube.
See Opening an Image Cube 58 .
Depending on the active window, click this button to save an image or your
multispectral dataset. See Saving Images and Image Cubes 54 .
Use this tool to zoom in on an image. See Zooming In and Out
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Click this button to return the current image magnification to 100%.
Click this button to pan the zoomed image that is currently active. The pointer
becomes a hand symbol. Pan the active image by clicking on the image and
dragging it to the desired view within its window.
Click this button to return the mouse pointer to its default pointer mode.
When sampling spectral signals for your spectral library, click this button if you want
to sample a rectangular region of pixels.
When sampling spectral signals for your spectral library, click this button if you want
to sample an elliptical region of pixels.
When sampling spectral signals for your spectral library, click this button if you want
to sample a line of pixels.
When sampling spectral signals for your spectral library, click this button if you want
to sample a freehand drawn region of pixels.
Click this button to open the Co-localization tool for co-localization staining detection
and analysis.
Click this button to open the Display Control to adjust the display settings
(brightness, contrast, display scaling, etc.) for the current image. See also
Customizing Spectral Displays 83 .

B. Control Panels
To select a control panel, click on its tab. The following panels are available:
The Acquire > Brightfield panel includes all the controls needed to acquire new brightfield
images and image cubes.
The Acquire > Fluorescence panel includes all the controls needed to acquire new
brightfield images and image cubes.
The Spectra panel is used to create spectral libraries and unmix cubes.
The Measure panel is used to find, measure, and adjust measurement regions in component
images.
The Display panel is used to change current display settings of images.

C. Status Bar
The Hardware Status box displays the current status of the camera: “No Hardware” or “Ready.”
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The Protocol drop down box displays the currently loaded protocol. It also lists all protocols opened
during the current session with Nuance.
The Cursor X/Y and Average Signal boxes display the coordinate location and signal level at the
cursor’s current position over any image.
Use the Macro drop down list and associated buttons to select and run macros. Nuance comes
with pre-recorded macros for acquiring and working with images, and these are listed in the Macros
drop down list. Any additional macros that you create and save will be added to this list as well.

D. Image Gallery
The image gallery displays the live image (when in acquisition mode) and the current opened or
acquired cube. The gallery also displays unmixed composite images and their component images,
as well as any other images open in the software.

E. Thumbnails and Image Data Pages
There are four pages with tabs across the bottom of the image gallery. You can change the viewable
size of these pages by clicking the Shrink or Grow buttons at the far right. These pages display the
following types of information:
The Thumbnails page displays a thumbnail of each image in the gallery. If you have more
than one cube open, you can double-click any cube thumbnail to display the cube and its
components in the gallery. If you have zoomed in on an image, the zoom view rectangle
within the thumbnail shows the zoomed region. (You can drag this rectangle with the mouse
pointer to pan the zoomed image.)
The Measurements page displays the measurement data of measurement regions drawn on
component images. See Quantifying Results 75 .
The Log page contains an action history of the current session. The log can be saved or
cleared by clicking the buttons at the far right of the page.
The Cursor page provides information about the image pixel at the current pointer location.
For cubes, it displays the average signal. For composites, it displays absolute and percent
contribution from each component. For other image types, it displays the pixel values.

3.7

Window Layout
Each window type has a home position on the screen. The cube lives in the upper left corner, the
composite image lives in the upper right corner, and the component images are positioned in a grid
starting from the lower left and working up and to the right.
Pressing Ctrl+L will force the windows to their home positions. In addition, many operations will force the
windows to their home positions. These include resizing the thumbnail view, unmixing a cube, or
activating a window from the thumbnail view.
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Resizing an Image Window
There are a few ways to change the size of an image window or windows.

To manually resize a window:
Click and drag its window border to the desired size. The image inside the window resizes to fill the
window, while also maintaining its aspect ratio.

To maximize the current window:
Click the window’s maximize button. The window will fill the image gallery.

To expand or reduce a window in steps:
Select Expand Window (or press Ctrl+E) or Reduce Window (or press Ctrl+R) from the Window
menu.

Zooming In and Out
You can zoom in to focus on details or zoom out to see more of an image.
Click the Zoom
button on the toolbar. The mouse pointer changes to a magnifying glass.
Use the magnifying glass to draw a box around the area you want to zoom.
You can also click the area of the image you want to zoom. Each time you click the image with the
Zoom tool, the zoom increases. In addition, you can scroll the mouse wheel to zoom in.

To zoom out:
Click the Full Image

button on the toolbar.

You can also right-click on a zoomed image and select Zoom To Full Image from the pop-up
menu. You can also scroll the mouse wheel to zoom out.

Panning a Zoomed Image
When you zoom in on a particular area of an image, you might not be able to see other areas of the
image.

To pan a zoomed image:
Do one of the following:
Right-click on the image and select Pan from the pop-up menu. The mouse pointer changes to a
hand icon. Click and hold the mouse button while dragging, or panning, to view the desired area of
the image.
Drag the zoom view rectangle that appears on the corresponding thumbnail image in the
Thumbnails tab.
Scroll the mouse wheel while holding down the Shift key (to pan horizontally) or the Control key
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(to pan vertically).

Panning All Images Simultaneously
Use the Zoom tool to zoom in on a particular region of the image cube. Next, hold down the Shift or
Control key and drag the upper left-hand corner of the zoom view rectangle on the cube’s thumbnail
image. All images will pan simultaneously. If you want to return all images to the full image view, click
the Full Image tool, then shift-click on the cube's thumbnail image.

Figure 11: Simultaneous Panning

3.8

Specifying Nuance Hardware Settings
You can specify a variety of settings and parameters for the camera in your Nuance imaging
system. To access the camera settings, select Hardware > Edit Hardware Settings > Camera.
A brief explanation of each setting is provided below:
CCD Bit Depth lets you capture either 8-bit (256-level) or 12-bit (4096-level) grayscale images per
wavelength. 12-bit images take up twice the memory and disk space of 8-bit images and can only
be opened using scientific imaging applications, including Nuance software. In most instances, it
is best to use the default 12-bit selection. This gives higher quality images. Many Microsoft®
Windows® applications cannot open 12-bit images. If you want to capture images that can be
displayed using non-scientific imaging applications, select the 8-bit option.
Gain affects image quality because it modifies the CCD readout process. For images that have
low intensities, consider increasing the gain value slightly to achieve images with brighter pixel
values. Increasing the gain can also reduce the exposure time. Note, however, that higher gain
settings can result in increased signal noise, which reduces image quality. Gain values of 1, 2, or
3 should be suitable for most applications.
Flip Image rotates the live image stream and new acquired images 180 degrees. Select this
check box if your images are upside down. (Previously acquired images are not affected.)
Check Dark Current is used to calculate the amount of background noise present in the camera.
This is calculated using a zero time exposure and no light reaching the camera.
Check Dark Frame is used to calculate the amount of background noise present in the camera.
This calibration is required for the Nuance software to support long exposure times (exposures
greater than five seconds). This calibration is done at PerkinElmer and takes approximately 30
minutes to complete.
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Frames to Average is a useful feature for reducing noise in acquired images by increasing the
signal-to-noise ratio. This value specifies the number of images the camera will take at each
acquisition wavelength. The software then averages the values of those images to create a single
image for each wavelength.
The signal-to-noise ratio increases approximately by the square root of the number of images
averaged. For example, averaging four images per wavelength gives a 2x signal-to-noise ratio. This
should translate into approximately a 2x reduction in the limit of detection.
Fluorescence/Brightfield Autoexpose target % of dynamic range sets the autoexposure
target values, and attempts to prevent saturation of pixels by restricting the exposure time to a
percentage of the dynamic range of pixel values. The defaults are 70% and 80%, respectively.
Enter a percentage for the dynamic range for autoexposure in fluorescence and brightfield. For
example, the default value of 70% for 12-bit (4096-level) images results in a maximum intensity
value of 2867.
The Maximum Exposure settings let you specify maximum exposure times (in seconds) for
fluorescence and brightfield:
User Defined Exposure sets the maximum value that a user can enter in the Exposure edit box
on the Acquire panels.
Auto Exposure sets the maximum exposure that is allowed to be returned when the user
autoexposes a fluorescence or brightfield image.

Scaling: Selecting a Measurement Pixel Unit
You can select Counts or Scaled Counts per Second as the measurement pixel unit. Select
Hardware > Edit Hardware Settings > Preferences. In the Measurement Pixel Unit box, select
one of the following options.
Counts: Measurements indicate count levels as read from the camera, so the indicated value
depends on the gain, binning, bit depth and exposure time used for a given measurement.
Scaled Counts/Second: Measurements indicate count levels after scaling for the effects of
exposure time, binning, camera gain, and bit depth, so the indicated value is essentially
independent of these settings. This is represented as follows:

* full scale =

4096 for 12 bit acquisitions
256 for 8 bit acquisitions

Displaying Image Cubes with Enhanced Contrast
The Display panel and the Display Control window (see Advanced Display Controls 86 ) both
include an Enhance Contrast check box that lets you display images with enhanced contrast. You
can control whether this box defaults to checked or unchecked each time a cube is acquired or
opened in Nuance.
1. Select Hardware > Edit Hardware Settings > Preferences.
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2. Check Display Image Cubes with Enhanced Contrast for either Fluorescence Images or
Brightfield Images, or both.
This selects how fluorescent and brightfield image cubes are shown when first acquired, or when first
loaded from disk. You can adjust the enhanced contrast setting for an image by using the check
box in the Display Control or the Display panel.

3.9

Calibrating Pixel Size
To take measurements using mm2 units, the Nuance software needs to know the camera’s pixel size
relative to the current magnification. This procedure requires that you have already acquired a clear and
focused monochrome image of a fiduciary at least 10 microns long, with the binning set to 1x1.
1. With the monochrome image of the fiduciary loaded, select Hardware > Calibrate Pixel Size.
The Distance Calibration dialog box opens.

Figure 12: Calib rate Pixel Size

2. Position this dialog box on the screen so the image of the fiduciary is visible. For this example,
a 1-micron by 1-micron grid was imaged at 40x magnification.
3. Select 1x1 in the Binning drop down box.
4. Select the units (µ m or mm) and enter the length of the fiduciary. (For this example, we used 10
microns.)
5. Click the Calibrate button.
6. Click with the mouse pointer on the acquired image at one end of a 10 µ m length.
7. Move the pointer to the other end of the 10 µ m length and click again.
8. The number of millimeters per pixel displays in the Conversion Factor field.
Getting Started with Nuance
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9. You can use the Check button to confirm that the calibration is accurate. To use the Check
function, obtain an image with points separated by known distances. Then click the Check
button and click on any two points in the image separated by a known distance. The correct
Measured Distance should be displayed.

3.10 Using Low Screen Resolution Mode
Nuance software only supports display resolutions of 1280x1024 or higher. However, some displays especially some digital projector displays - do not support resolutions this high. The Nuance software
has a special mode to support projectors or screens at 1024x768 resolution. Some software functions
are not available in this mode.
Screen resolution is detected at startup. A dialog box warns if you are running in low-resolution mode. If
the Nuance software is started, and the screen resolution is subsequently changed, the Nuance
software will not detect it. If the Nuance software is run with a screen height of 800 pixels or less, it
makes the following adjustments:
In low-resolution mode, spectral libraries can only have five elements. This effects the Spectra
and Display panels as well as the Batch Mode, Import Spectral Library, and RCA dialog
boxes.
The toolbar is removed from under the main menu.
The Sample ID and Notes boxes are removed from the Fluorescence panel.
The Notes box is removed from the Spectra panel.
Plots on the Manual Compute Spectra dialog box are 4/5 their normal size.
The spectral graph (for cube display) is removed from the Display panel.
The status bar at the bottom of the screen does not display.

3.11 Reinitializing Nuance Hardware
When you start the Nuance software, it automatically detects the Nuance camera/imaging module
hardware if it is attached to the computer via the USB 2.0 cable. If the Nuance software loses its
connection to the hardware, make sure the USB 2.0 cable is properly connected to the imaging module,
then select Hardware > Reinitialize. Nuance should detect and initialize the hardware. If this fails to
reinitialize the connection, try restarting the Nuance software.
If the computer’s power save feature is enabled, the computer will enter sleep mode if left inactive for a
length of time. Turn this feature OFF. If the computer goes to sleep while it is connected and running the
software, the connection with the camera/imaging module is lost. Reboot both the imaging module and
the computer to reconnect.
Avoid this problem by making sure the computer is set to never enter sleep mode. This will prevent
losing the hardware connection between the computer and system.
1. Click Start > Control Panel > Power Options to display the dialog box.
2. On the Power Schemes tab, select Always On in the Power schemes drop down box.
3. You can select any time period for the Turn off monitor setting. The Turn off hard disks and
System standby options must be set to Never.
4. Click Apply and then OK and close the Control Panel.
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4

Method Development
Method development is a fundamental component of any good experiment, and building spectral libraries
is a key part of method development. This section discusses methods for building accurate and reliable
spectral libraries. We will explain how to create and save libraries using a variety of sample specimens,
and we will discuss their unique characteristics. The Unmixing Spectral Images 40 section discusses
how to open libraries and use them to unmix images.
If you are new to the Nuance multispectral imaging system and have not already familiarized yourself
with the rest of this manual, we suggest that you do so now. Then return to this topic for further study.

4.1

Methods for Building Spectral Libraries
You should create a spectral library for each of your experiments or series of experiments. Acquire or
open the image cube you want to use to create the library. The Brightfield and Fluorescence Imaging 40
topics describe in detail how to acquire image cubes of your specimens.
There are a number of ways to build a spectral library. A few examples include:
Using the Real Component Analysis (RCA) feature to automatically compute and unmix spectra
(see Computing and Unmixing Spectra Automatically 58 for detailed instructions). This process
adds spectra to the library, which you can modify as needed and then save.
Using the Manual Compute Spectra feature, which lets you specifically sample spectral
signatures from images and save them in a library (see Computing and Unmixing Spectra
Manually 61 for detailed instructions).
Adding spectra from other libraries, component images, or composite images of the same or
similar specimens (see Importing Spectra Into a Library 36 ).
Also, depending on the nature of your experiment and the types of dyes or fluorophores used, you
may have imaged a single slide or two slides from which you will obtain the spectra of the pure
autofluorescence and that of a single dye mixed with autofluorescence, if present. These can be
used directly in the spectral library or after “pure spectra” calculation.
After building the library, save it as described in the Saving Spectral Libraries

35

topic.

Tips for Spectral Library Development
There is no substitute for proper library spectra. If possible, use samples stained with single
components for determining the spectra of chromogens or fluorophores of interest, using one or
more sections for each label.
The computed pure spectrum should be similar to, but not necessarily the same as, published
spectra of that chromogen or fluorophore. Variations in the label’s physical environment within
tissue can cause spectral shifts.
Verify that your libraries work correctly by testing them on a few positive and negative controls.
Use critical judgment during this evaluation.
Some chromogens slightly change optical characteristics with hematoxylin counterstaining. Use
the Manual Compute Spectra tool to generate an appropriate spectrum after counterstaining.
Unmix into white or pink for autofluorescence. Unmix into red, green and/or blue (or more colors)
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for chromogens or fluorophores of interest.
If you want to make a chromogen or fluorophore (i.e., autofluorescence) “disappear,” assign it to
the black channel or simply turn the layer off in the Display Control utility (see Advanced Display
Controls 86 ).
Make sure you save the library for later use.

Obtaining Counterstain and Label Spectra from a Brightfield Sample
In this example, obtain the pure spectra of a chromogen and the counterstain present in the Ki67
data set. (The Ki67-20X data set comes with the Nuance software and is located in the Nuance
sample data folder: C:\Nuance Data\Images\Sample Data\. Double-click the “k i67-20X.im3” file to
open the cube.) Remember, you must be able to identify the pure and mixed spectra of the
specimen to compute pure spectra and provide proper libraries.
Obtain the hematoxylin (counterstain) signal of the tissue background from an area of pure (blue)
counterstain only (blue spectrum, Label #3 in the figure below).
Obtain the mixed DAB signal plus hematoxylin from the nuclei that have both spectra (green
spectrum, Label #2 in the figure below).
In this example, use Manual Compute Spectra to calculate the pure spectra of DAB (red
spectrum, Label #1). Save the spectral data in a spectral library.
(These steps are explained in detail in the Practice Exercise
Guide.)

32

Nuance Multispectral Imaging System

37

and in the Nuance Quick Start

Figure 13: Counterstain and Lab el Spectra from a Brightfield Sample

Notes:
In this example, the counterstain signal is named “Pure Hematox.”
The Zoom

tool can be used to help visualize the drawing tool on particular pixels.

When computing pure spectra, observe the plots of the spectral curves in the Spectral Graph.
Each plot should have a curve similar to that shown in the figure above. In this sample, the Scale
option was turned off during Manual Compute Spectra.
Compare computed pure spectra with that of known sources in published literature.
Note that the unmixed hematoxylin signal reveals the pale-staining germinal center cells.

Obtaining Autofluorescence and Label Spectra from a Fluorescent Sample
In this example, obtain the pure spectra of the two fluorophores present in the kappa lambda
fluorescence cube of tonsil tissue. (The kappa lambda data set comes with the Nuance software and
is located in the Nuance sample data folder: C:\Nuance Data\Images\Sample Data\. Double-click
the “k appa lambda tonsil 605 655.im3” file.)
Remember, you must be able to identify the pure and mixed spectra of the specimen to compute
pure spectra and provide proper libraries.
Obtain the autofluorescence signal of the tissue background from an area of pure
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autofluorescence (black spectrum, Label #9 in the figure below).
Obtain the mixed 605 nm quantum dot fluorescence plus autofluorescence from cells that have
both spectra (blue spectrum, Label #3 in the figure below).
Obtain the mixed 655 nm quantum dot fluorescence plus autofluorescence from cells that have
both spectra (yellow spectrum, Label #4 in the figure below).
In this example, use Manual Compute Spectra to calculate the pure spectra of each quantum dot.
Save the spectral data in a spectral library.

Figure 14: Autofluorescence and Lab el Spectra from a Fluorescent Sample

Notes:
In this example, the pure fluorescence signals are named “Pure 605 qdot” and “Pure 655 qdot.”
The Zoom

tool can be used to help visualize the drawing tool on particular pixels.

Notice that the Blue and Yellow lines disappear, and Red and Green lines representing the pure
605 nm and 655 nm signals appear in the Spectral Graph.
When computing pure spectra, observe the plots of the spectral curves in the Spectral Graph.
Each plot should have a uniform Gaussian curve similar to that shown in the figure above.
When computing pure spectra, adjust the Scale and Fit Offset options to obtain a spectrum that
best fits the pure spectrum of the signal.
Compare the computed pure spectra with that of known sources in published literature.
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4.2

Saving Spectral Libraries
By saving your spectral libraries, you make them available for use again later when performing analyses
on similar specimens. Instead of just saving the library, you could also save the Nuance protocol, which
saves all of the Nuance acquisition and analysis settings (see Saving Protocols 35 for how to save
protocols.)
1. Select File > Save Spectral Library. The Choose Spectral Library dialog box opens.
2. Navigate to the folder where you want to save the spectral library and type a name in the File
Name field.
3. Make sure “Spectral Libraries (*.csl)” is selected in the Save as type box and click the Save
button.
If you want to be able to open the library in another application such as Microsoft® Excel® to review or
graph its numerical data, you can save the library as a text file. Select the “Text Files (*txt)” option. Note
however, this format does not include all of the information the .csl file includes (for example, it cannot
save color or hardware settings) so do not use it to save and share your libraries.

4.3

Saving Protocols
The Nuance software saves its settings in protocols. Protocols are recipes for collecting and measuring
data, and they contain the following information:
acquisition settings including region of interest and binning, wavelength settings, filter selections,
exposure times, and hardware settings.
associated spectral library
auto save options
measurements options including threshold level and minimum connected pixels
Whenever you make changes to any hardware settings or acquisition settings, or edit the current
spectral library, save those settings in the current protocol or create a new one. By saving your
protocols, you make them available for use again later when acquiring image cubes of similar
specimens.
1. Select File > Save Protocol.
2. In the Choose Protocol dialog box, select the name of an existing protocol if you want to
overwrite it, or enter a new name in the File Name field.
3. Click Save to save the protocol.
4. Notice that the new protocol name appears in the Protocol drop down box on the status bar. If
other protocols were loaded during the current session of Nuance, you can select and re-load
them from the Protocol drop down box.
Note:

When you exit the Nuance software, you will be prompted to save the current protocol if
you have changed any hardware or software settings during the current session. Be sure
the save the protocol if you want to use the new settings again.
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4.4

Importing Spectra Into a Library
From an Existing Library
You can import individual spectra from other libraries.
Note:

The spectral range and spectral spacing
parameters of the library must be the same as
current loaded spectral cube data.

1. Click the Import Spectra From Library button on
the Spectra panel.
2. The Choose Spectral Library dialog box will
prompt for the file name of a spectral library.
Spectral libraries have a .csl file name extension.
Spectral libraries from older versions of the software
with *.txt file extensions may also be opened.
3. Double-click the name of the library to open it.
4. The Import Spectra From Library dialog box
opens. It lists all the spectra stored in the selected
library.
5. Make sure there is a check-mark in the Select
column next to each spectrum you want to import.
Select a Location Number and click the Transfer
to Library button.

Figure 15: Import Spectra

6. If you want to load spectra from another library, click the Load button and select another library
to load. The Clear Current Library button removes all spectra from the current library (same as
the Clear All button on the Spectra panel).
7. Click Close when finished importing spectra.

From a Saved Component Image
You can import spectra from component images.
1. Open the Result Set (.umx) file that includes the component image from which you want to
import spectra.
2. Right-click on the component image and select Import Spectra from the pop-up menu.
3. The Import Spectra From Library dialog box (see Import Spectra
spectrum used to unmix the cube into that component.
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figure) opens with the

4. Make sure there is a check-mark in the Select column next to each spectrum you want to
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import, then click the Transfer to Library button.
5. If you want to load spectra from another library, click the Load button and select a library to
load. The Clear Current Library button removes all spectra from the current library (same as
the Clear All button on the Spectra panel).
6. Click Close when finished importing spectra.

From a Saved Composite Image
You can import spectra from composite images.
1. Open the Result Set (.umx) file that includes the composite image from which you want to
import spectra.
2. Right-click on the composite image and select Import Spectra from the pop-up menu.
3. The Import Spectra From Library dialog box
cube.
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opens with all the spectra used to unmix the

4. Make sure there is a check-mark in the Select column next to each spectrum you want to
import, then click the Transfer to Library button.
5. If you want to load spectra from another library, click the Load button and select a library to
load. The Clear Current Library button removes all spectra from the current library (same as
the Clear All button on the Spectra panel).
6. Click Close when finished importing spectra.

4.5

Practice Exercise
In this exercise you will open and analyze a brightfield image cube representing a lymph node specimen
stained for Ki67. B-cells are on the left, T-lymphocytes are on the right, and all nuclei are stained. Some
cells are positive (brown) for the Ki67 proliferation marker, and all cells have a blue hematoxylin nuclear
counterstain. By using Nuance multispectral imaging, we will be able to see the blue counterstain
underneath the brown Ki67 marker.
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1. To open the sample Ki67-20X image cube click
the Load Cube button and navigate to the
Nuance sample data folder: C:\Nuance
Data\Images\Sample Data\.
2. Double-click the “k i67-20X.im3” file to open the
image cube.
3. This cube has not yet been converted to “optical
density,” which should be done prior to
unmixing. Select Tools > Convert to OD - Auto
selects white spectrum. (See About Optical
Density Images 42 for more information about
optical density conversion.)
4. The Ki67 cube is now ready for unmixing.
5. Manually obtain spectra and use Manual
Compute Spectra to unmix the cube:
a. Select the Spectra panel.
b. Obtain the hematoxylin (counterstain) signal
of the tissue background from an area of
pure (blue) counterstain only: Click the
Draw button in row #3 and draw a line over
some of the blue nuclei on the right. When
you release the mouse button, a checkmark appears in the Select column in the
Library. Change its default name from “C3”
to a more descriptive name like “Pure
Hematoxylin.”
c. Obtain the mixed DAB signal plus
hematoxylin from the nuclei that have both
spectra: Click the Draw button in row #2,
then draw a line within a brown (mixed)
nuclei on the left. A check mark appears in
the Select column in the Library. Name this
spectrum “DAB+Hematoxylin.”

Figure 16: Manual Compute

d. Click the Manual Compute Spectra button
to calculate the pure spectra of DAB and
save the spectral data to the Library.

a. In the Known Spectrum group, click the blue “Pure Hematox” spectrum.
b. In the Mixed Spectrum group, click the green “DAB+Hematox” spectrum.
c. The computed pure DAB spectrum will display in the Computed Spectrum group.
d. Select the Scale and Fit Offset check boxes. These functions fine-tune the spectral
computation and will result in a better unmixing in this example due to the weakness of the
signals that are being unmixed. See Error Scaling When Manually Computing Spectra 63
for more about these functions.
2. Make sure the computed spectrum is assigned to row #1 and its name to “Pure DAB.” Click
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the Transfer to Library button and close the dialog box.
3. In the Library, make sure that only the Blue and Red markers (representing both of the pure
spectra) are selected. Click the Unmix button to generate the properly unmixed set of images
(shown in the figure below).

Figure 17: Unmixed Fluorescence Signals
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5

Brightfield and Fluorescence Imaging
This topic explains how to set up your microscope for brightfield and fluorescence imaging and then
acquire images using the Nuance system’s image acquisition functions. During this topic, it is presumed
that you are familiar with the general procedures of brightfield imaging and fluorescence imaging in
microscopy. The workstation computer and imaging module should be powered up and ready as
described in Launching the Nuance Software 22 .

5.1

Setting Up Your Microscope for Brightfield Imaging
Accurate imaging depends on proper alignment and operation of the microscope. Because multispectral
imaging acquires a cube of images over the visible spectrum, the quality of the objective lens is
important. The eye is most sensitive to green light, which is usually chosen, and is the Nuance default,
for focusing a live image. The live image is always in gray scale, not color, because the Nuance camera
collects gray scale images at each of the wavelengths selected by the user.
Notes:

Apochromatic lenses on microscopes are corrected for multiple colors and provide
essentially constant focus throughout the visible spectrum. If at all possible, apochromatic
lenses should be used for multispectral imaging.
Achromatic lenses, on the other hand, are not as highly corrected and therefore the focus
is not perfect over the entire spectral range. If one focuses an achromatic lens in the green
wavelength, the same image will be slightly out of focus at blue and red wavelengths. The
result being that any image collected with an achromat lens will display color fringes
around every object in the image. While this may not be too apparent without close
scrutiny, it will affect the ability to collect accurate data (particularly with respect to areas)
from such images. Achromatic lenses should not be used for multispectral imaging.

The microscope illumination system should be carefully aligned for Koehler illumination 117 . This ensures
that the light available from the illuminator fully illuminates the objective being used. While Koehler
illumination will achieve the best performance available for a given condenser and objective combination,
it does not ensure even illumination of the field of view. If the microscope lamp has controls for centering
and focus of the illumination source, these should be carefully adjusted to provide the most even
illumination possible in the field of view.
One way to accomplish this lamp adjustment is to capture images of a blank field after finding a focus
plane using a stained slide and adjusting for Koehler illumination. This blank-field image can then be
examined using the mouse pointer in Nuance, and the intensity of white pixels in the center of the
screen can be compared to those at the edges and corners of the screen. It will be difficult or impossible
to achieve identical illumination over the entire field of view. However, you should adjust the lamp to
achieve the most even illumination as possible. Any remaining variations in intensity will be corrected by
the flat fielding algorithm, which is part of the brightfield acquire procedure in Nuance.
Koehler illumination is specific for each objective used on the microscope. In other words, every time the
magnification is changed, the microscope should be checked for proper Koehler alignment. Also, each
time you change the magnification, you must also collect a new “reference cube” in order to ensure
correct flat fielding of the image. This provides a baseline for performing an optical density (OD)
conversion of the image data. Be certain to adjust the condenser diaphragm correctly for optimum image
quality. Closing the condenser diaphragm too far will produce exaggerated contrast in the image, and will
degrade image quality.
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5.2

Setting Up Your Microscope for Fluorescence Imaging
Setting up a microscope for fluorescence is highly variable, and depends on the brand and model of the
microscope being used. Almost all fluorescent microscopes in use today, both upright and inverted, use
a version of the Ploem or vertical illuminator system. The critical portion of this unit is the “filter cube,”
which is made up of two narrow band filters and a dichroic mirror. The filter cube turns the excitation light
through 90 degrees, in order to direct light from the lamp to the objective of the microscope.
In the vertical illuminator arrangement, the objective being used for examination is also used for
illumination. This ensures that if the specimen is in focus, the illumination is also in focus at that point
on the specimen. Another feature of this illumination system is that only the part of the specimen that is
visible through the objective is being illuminated, and this assists with issues such as fluorophore fading
with exposure to excitation illumination.
The first narrow band filter in the filter cube is an excitation filter. This filter passes light from the lamp
that excites the particular fluorophore in use. It is chosen to pass a very narrow range of excitation
wavelengths.
The dichroic mirror is used to reflect the chosen excitation wavelength of light to the specimen. A unique
property of dichroic mirrors is that the mirror reflects only the wavelength desired for excitation, and
passes other wavelengths that have passed through the excitation filter out of the optical path of
illumination.
The result is that the combination of the excitation filter and the dichroic mirror produces an even
narrower band of excitation than could be generated by either the excitation or the dichroic mirror alone.
The final filter in the filter cube is the emission filter. This filter is a narrow band filter that selects the
emission wavelength of interest. It also works in combination with the dichroic mirror to provide a very
narrow band of emission wavelengths. It should be appreciated that the entire filter cube and vertical
illuminator arrangement is designed to select a very narrow band of excitation and a very narrow band of
emission.
Since current fluorescence microscopes are designed for very narrow wavelengths of excitation and
emission, they may complicate the use of multispectral imaging, which is designed for evaluation over
extended wavelength ranges. In order to overcome these limitations, the filter cube should be
reconfigured by replacing the emission filter with a longpass filter. The longpass filter should pass all
wavelengths starting just above the wavelength being used for excitation.
When multiple fluorophores are used on a single specimen, these fluorophores should be chosen to
excite with similar excitation wavelengths. If the fluorophores require widely differing excitation
wavelengths, then two or more excitation/emission filter sets may be required to collect the desired data
in a single image cube. The Nuance software’s Multi Filter Support feature lets you acquire an image
cube using multiple excitation/emission filters sets.
Fluorescence microscopes are generally illuminated by lamps providing wavelengths that are “bluer” than
normal incandescent (filament) bulbs. These are often of the arc lamp type, and provide small point
sources of illumination. As small points of high intensity, lamp alignment in fluorescent microscopes is
critical. Various microscopes have different tools to assist with lamp alignment, and the manufacturers
instructions should be carefully followed. The objective is to provide the most even illumination possible
at the specimen. This is made more difficult as the eye cannot see the actual illumination, unless there
is a fluorophore present. And to check the entire field, one needs a specimen that provides an identical
response over the entire image area.
One type of specimen that meets this requirement is the various types of plastic slides available from
providers of fluorophores. These slides fluoresce when exposed to excitation light, and by acquiring an
image of such a slide, one can check for even field excitation. Using such a field standard, the lamp
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should be adjusted to provide as even illumination as possible.
Note:

When performing fluorescence imaging using the Nuance system, be certain that the
wavelength selected for the “live” image used to focus is set to the expected emission
wavelength of the fluorophore being imaged. If the live wavelength is set to the excitation
wavelength, you will not see an image, and it will be impossible to correctly focus.

In all fluorescence work, it is important to minimize exposure to the florescence excitation, and for
quantitative work, one should avoid collecting images from areas of the specimen already examined. If
multiple image cubes are required, take care to minimize total exposure time to the excitation light.

5.3

About Optical Density Images
Optical Density (OD) is used to measure the interaction of light with absorbing materials. The science of
absorbing spectroscopy is based on the Beer-Lambert law, which states that if the molar extinction of a
true absorbing material is known, and the absorber is homogeneously distributed, then the amount of
material present is the negative logarithm of the percent transmission. Percent transmission is defined
as the amount of light present without the specimen (100%) as compared to the amount of light present
with the specimen in the light path. Since the molar extinction is constant for a given material, we can
assume that this is a non-varying term, and ignore it for all practical purposes.
When absorbing images collected in brightfield are converted to OD images, the information contained in
each pixel is quantitative, as to the amount of absorbing material present. In the case of brightfield
microscopy, the absorbing material is an applied dye of some type. If we know the manner of
attachment of the dye to sites within the specimen, we have a quantitative measure of a particular
component within the specimen. In the case of many histochemical stains, this can result in an
accurate measure of a particular chemical constituent within the specimen.

Automatic OD Conversion
The Nuance system automatically generates optical density values in brightfield images. To do this,
you must first collect a reference cube, which provides the 100% light level needed for the OD
computation. If you open an image cube that has been collected without a reference cube, the
Nuance system can still generate OD images based on the white (100% transmission) values within
the image cube.
In either case, accurate OD images result, and the resulting OD values reflect the actual amount of
absorbing material present. Therefore OD conversion should always be employed if quantitative
information regarding the amount of dye is desired.

Non-OD Converted Images
The Nuance system can unmix brightfield images that have not been converted to optical density. In
this case, the resulting unmixed images are not quantitative. The reason to perform such an
analysis might be simply to produce unmixed image results or composite images that have
exaggerated visual contrast.
In certain cases, one might find such images advantageous for certain types of image segmentation,
but it should be understood that these images are accurate only in terms of spatial areas, and no
longer contain quantitative data with respect to amount of chromogen present. PerkinElmer does not
recommend using non-OD converted images.
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5.4

Tips for Obtaining Quantitative Results
Whenever possible, acquisition of image cubes should be done using previously established
Nuance protocols that have been saved and validated with your Nuance imaging system for each
of your specimens/experiments. Protocols are recipes for collecting and measuring data.
Protocols are discussed further in Saving Protocols 35 .
Set up all hardware identically each time you acquire images during the course of an experiment.
Orient all samples similarly. Use the Live Image Overlay
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feature.

Obtain a spectral library from known control samples.
Use one spectral library for unmixing all datasets.
Use the same gain, binning, spectral ranges, and exposure times for all measurements.
Save resulting images as “Unscaled Data” so they can be exported to other quantitation software,
if desired.

5.5

Acquiring Images Using a Saved Nuance Protocol
Nuance protocols are recipes for collecting and measuring data. By using a saved protocol to acquire
images of similar specimens throughout an experiment, you don’t have to specify acquisition settings
every time. This helps ensure consistency throughout the experiment.
If a Nuance protocol has already been saved, tested, and validated for the type of specimen/cube you
want to acquire, load the protocol first, then acquire the cube using the settings from the protocol.
Note:

Be aware that using a protocol from one specimen to acquire an image of a specimen that
contains different fluorophores will lead to incorrect results.

Opening a Protocol
Tip:

The Protocol drop down box on the status bar lists all protocols that were opened during
the current Nuance session. If the desired protocol was opened earlier, select it from this
list. Otherwise, use the following method.

1. Select File > Open Protocol.
2. Nuance may ask if you want to save the current protocol if one is open and changes have been
made.
3. In the Choose Protocol dialog box, select the protocol you want to open and click Open.
4. Nuance now contains all the settings of the selected protocol including the last saved exposure
and wavelength.
Tip:

You can also open a Nuance protocol by double-clicking the protocol (*.pro) file in a My
Computer directory window. If Nuance is not already open, this action will open Nuance
with the selected protocol. You can also drag a protocol file and drop it into an open
Nuance window to open the protocol.

Brightfield and Fluorescence Imaging

43

5.6

Viewing a Live Image Stream
The frame rate of the live image varies according to the set exposure time. If you see an all black image,
the exposure setting is probably too low. Saturated pixels appear red in the live image. If some or all of
the image is solid red, the image is saturated. The exposure setting may be too high.
1. Use the eyepieces and the stage/focal controls to position/focus the specimen for viewing. Then
divert all of the light to the camera and make sure the Nuance slider is in the MSI position, not
the MONO position.
2. For brightfield imaging, switch to the Brightfield acquire panel; for fluorescence imaging, switch
to the Fluorescence acquire panel. The Live Stream window opens automatically. (If you
closed the Live Stream window, click the Live button.)
3. Click the AutoExpose Mono button to automatically adjust the exposure time to the best
setting for the current wavelength.
4. Fine-tune the focus if necessary.

Applying a Live Image Overlay
When quantitative results are needed, use the Live Image Overlay feature to help you orient the
current specimen as when it was previously imaged. Open the image you want to use as an overlay.
Then right-click the image and select Set As Live Image Overlay. See also Live Overlay 84 .

Freezing the Live Image
Click the Live button a second time. The image in the Live Stream window remains frozen until
you click the Live button again.

5.7

Selecting Camera Binning and a Region of Interest
Binning combines multiple pixels into a single pixel. Higher binning reduces exposure time and image
size but results in a lower resolution image. There are three camera binning options in the Binning
selector. For brightfield images, this selector defaults to no (1x1) binning. For fluorescence imaging, the
default is 2-pixel (2x2) binning.

Figure 18: Region Of Interest And Binning
Selectors

Select one of the following:
If you want no binning, for maximum image resolution and size, select the 1x1 binning option.
2x2 binning combines each 2x2 square of pixels into one pixel. This reduces the resolution in
each direction by a factor of 2 and requires 1/4th the exposure time.
4x4 binning combines each 4x4 square of pixels into one pixel. This reduces the resolution in
each direction by a factor of 4 and requires 1/16th the exposure time.
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The ROI (Region of Interest) selector sets the imaging area, which may be set to include all or just a
portion of the entire field of view. The active area is always centered, and there are five ROI options in
the ROI selector. Four options are predefined, and one is user-definable. The default setting is Fullframe.

Selecting a Region of Interest
Do one of the following:
To capture the Full-frame, 2/3-frame, 1/2-frame, or 1/3-frame, select from the predefined options.
To select a custom region of interest, select “Custom” and use the mouse pointer to draw an ROI
box within the Live Stream window. You can also create a custom region of interest by
selecting Hardware > Set Custom Camera ROI.

5.8

Specifying the Current Wavelength and Exposure
The Wavelength And Exposure boxes are used to manually adjust the current Wavelength in
nanometers (nm) and the Exposure in milliseconds (ms).

Adjusting the Current Wavelength
Depending on the expected wavelength of the emission light, you may need to adjust the current
wavelength for the filter being used. The Wavelength (nm) box is used to set the wavelength in
nanometers for manual control of the live camera view.

To manually set the current wavelength:
Do one of the following:
Drag the slider to the desired wavelength. The slider snaps to the wavelength intervals set in the
acquisition settings. As shown in this figure, the wavelength slider indicates the current filter
range. The highlighted region on the slider represents the acquisition wavelength range. The
colors on the slider approximate how we would see the wavelengths within the range.
Type a value or use the up/down scrollers in the Wavelength text box. When typing a value, you
can set the wavelength in 1 nm increments. The up/down scrollers snap to 10 nm intervals.

Figure 19: Wavelength and Exposure
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Adjusting the Exposure Time (Autoexpose)
Use the autoexposure buttons to automatically determine the correct exposure setting, or manually
enter a value (in milliseconds) in the Exposure entry field. You can also use the Custom
Wavelengths And Exposures option. This option is enabled only if custom collection settings have
already been specified. (See Specifying Custom Wavelength and Exposure Settings 46 ).

To autoexpose at the current wavelength:
Click the Autoexpose Mono button. Nuance will calculate the best exposure time for the current
wavelength and display the value in the Exposure text box.

To autoexpose a cube:
1. Before you acquire an image cube, click the Autoexpose Cube button.
2. If you are using the multiple filter feature (see Acquisition Setup Using Multiple Filters 50 ), the
system will prompt you to install the correct filter set. Install the requested filter set before
continuing.
3. Nuance will calculate the exposure time(s) that should be used to acquire an image cube of the
specimen. The value at the current wavelength will display in the Exposure text box. You may
also notice that the Use Custom Wavelengths and Exposures check box automatically
becomes selected. This occurs when different exposure times are required for individual cube
wavelengths.

To manually enter an exposure time:
Type an exposure value into the Exposure (ms) text box or use the scrollers to increase or
decrease the current value in increments of one millisecond. As you change the exposure setting,
you will see the live image become brighter or darker.
Note:

Be careful not to overexpose or underexpose your specimen. Doing so may result in loss
of valuable data, which will affect spectral classification or unmixing operations later.

If you are using the multiple filter feature (see Acquisition Setup Using Multiple Filters 50 ), you can
enter a different exposure time for each filter in the sequence. Select the first filter letter (“A”) in the
Multi Acq drop down box and enter an exposure time. Repeat for each filter in the filter sequence.

To use custom wavelengths and exposures:
If you have specified the custom settings, select the Custom Wavelengths And Exposures check
box. You may now acquire the cube using the custom collection settings.

Specifying Custom Wavelength and Exposure Settings
Custom wavelength and exposure settings let you use unevenly spaced wavelength settings and
varying exposure times to acquire an image cube. You can specify new settings and save them, or
you can load a saved wavelength and exposure table.

To specify custom wavelength and exposure settings:
1. Select Hardware > Edit Hardware Settings (or press Ctrl+H) to reveal its dialog box.
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2. Click the Brightfield Custom tab or the Fluorescence Custom tab.
3. The Wavelength/Exposure table defaults to the acquisition settings of the currently selected
presets.
4. To change the defaults, specify new Start/End Wavelengths and Step interval using the drop
down boxes in the Fill Wavelengths area below the table.
5. Specify the exposure Time (milliseconds) in the Fill Exposures box.
6. Return to the Wavelength/Exposure table and edit individual settings as necessary.
7. Click Save to save the settings and close the dialog box.
8. On the Brightfield or Fluorescence panel, select the Use Custom Wavelengths And
Exposures option to use the custom collection settings to acquire the image cube. (All fields in
the Cube Wavelength Selection group become disabled.)

To save custom collection settings as a table to load again later:
1. After specifying custom collection settings, click the Save button. The Choose Custom Table
dialog box opens.
2. Specify a directory and filename and click Save to save the new wavelength and exposure
table.

To load a wavelength and exposure table:
1. Click the Load button on the Brightfield Custom or Fluorescence Custom tab, respectively. The
Choose Custom Table dialog box opens.
2. Locate the table you want to load and click Open. The collection settings appear in the
Wavelength/Exposure table. Click OK to use the custom settings.

5.9

Acquiring Cubes in Brightfield
Selecting Cube Wavelengths
The controls within the Filter/Wavelength Selection group control the acquisition wavelength
settings for acquiring spectral cubes.

Figure 20: Spectral Cub e Acquisition Controls

Enter the start, step, and end values to be used to acquire the spectral cube. The values shown in
this figure represent the default values for cube acquisition in brightfield.
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Narrow Bandwidth Acquisition (FX & EX models only)
Narrow mode can help you obtain better resolution of closely spaced and overlapping emission
spectra. It can also increase the number of chromogens or fluorophores in your sample by using
more overlapping spectra. (See also Nuance FLEX Multispectral Imaging 15 .)
If your Nuance camera is equipped with a Flex filter, and you want to use its narrow bandwidth
capability, select the Narrow check box on the Brightfield panel.

Acquiring a Raw Cube (No Post Processing)
When the Nuance system takes a spectral cube in brightfield, it automatically flat-fields the images
and converts them to optical density. In order for this to occur, you need to acquire a reference
image before you can acquire a cube. If you do not want this automatic conversion to occur (and you
want to skip acquiring a reference image), then clear the Convert to OD check box. Cubes will now
be taken without automatic conversion to optical density. (See also, Taking a Reference Image for
Flat Fielding 51 .)

Acquiring a Brightfield Cube
1. Click the Autoexpose Cube button to start an autoexposure sequence for the cube. (See also,
Adjusting the Exposure Time (Autoexpose) 46 .
2. It is highly recommended that you leave the Convert to OD option checked when acquiring
cubes. If you turn off this conversion feature, you may notice that the outer edges of the image
are slightly darker than the rest of the image. (See also, Taking a Reference Image for Flat
Fielding 51 .)
3. If you selected the Convert to OD option, acquire a reference image: Move the specimen out of
the live view so that nothing but empty white background is visible (typically still on the glass
slide, but off the tissue specimen).
4. Click the Acquire Reference button.
Note:

If you change the binning or field of view, the current reference image becomes invalid.
You will have to take a new reference image before acquiring cubes with a different binning
or field of view.

5. After acquiring the reference image, click the Acquire Cube button.
6. When the Nuance system has completed taking the image cube, a color representation of the
cube now in memory displays in the image gallery.
7. If you intend to save this cube, save it now as described in Saving Images and Image Cubes

5.10 Acquiring RGB (Color) Images
The RGB acquisition functions are found on the Brightfield acquisition panel.
1. Select a region of interest and binning. See also Selecting Camera Binning and a Region of
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2. Select the wavelength and exposure. See also Specifying the Current Wavelength and Exposure
45 .
3. Click the Autoexpose RGB button to start an autoexposure sequence to determine exposure
values that the imaging module believes to be optimal for the RGB image.
4. Click the Acquire RGB button to acquire a single color picture of the live image.
Note:

PerkinElmer does not recommend the use of this function. Better color fidelity will be
obtained using OD-converted MSI (multi-spectral imaging) data.

5.11 Acquiring Fluorescence Cubes
Selecting Cube Wavelengths and a Filter
Filter settings define the wavelengths for which the filter is tuned when acquiring an image cube.
The Cube Wavelength Selection group has preset acquisition settings as well as entry fields for
manually entering cube wavelengths.

Figure 21: Filter/Wavelength Selection

Using Preset Filter Settings (fluorescence imaging only)
The predefined filter and wavelength settings on the Fluorescence panel store fixed filter names
with their corresponding acquisition wavelengths. For example, “FITC (500 : 10 : 720)” means the
starting wavelength is 500 nm, the ending wavelength is 720 nm, and images are acquired in steps
of 10 nm.
Select an option from the drop down box. The wavelength setting for the Live image autoadjusts to
within the wavelength range of the current selection.

Manually Entering Acquisition Settings
If you don’t see the filter settings you want in the presets drop down box (for fluorescence imaging),
you can edit the current values in the Start, Step, and End wavelength text boxes. When you edit
any of these values, a new “Unnamed” filter setting is automatically created using the new manual
settings.
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Narrow Bandwidth Acquisition (FX & EX models only)
Narrow mode can help you obtain better resolution of closely spaced and overlapping emission
spectra. It can also increase the number of chromogens or fluorophores in your sample by using
more overlapping spectra. (See also, Nuance FLEX Multispectral Imaging 15 .)
If your Nuance camera is equipped with a Flex filter, and you want to use its narrow bandwidth
capability, select the Narrow check box.

Customizing the Preset Filter Settings
You can edit and save changes to the preset filter settings for fluorescence imaging:
1. Select Hardware > Edit Hardware Settings (or press Ctrl+H) to reveal its dialog box. Click
the Filters tab. (Filter settings that you enter and save here become available for use in your
Nuance acquisition protocols.)
2. Edit the settings as needed:
To edit existing settings, select the filter setting name in the list and edit its tunable filter
settings. Click the OK button to save.
To create a new filter setting name with a new set of tunable filter settings, click the New
button. Enter a label name and click OK to add the new filter setting name to the list. Then
specify its tunable filter settings and click the OK button to save.
To delete a currently selected filter setting name, click the Delete button.
To restore all preset filter settings to their factory defaults, click the Factory Defaults
button. This will also delete all new filter setting names you have saved.

Acquisition Setup Using Multiple Filters
The Nuance system offers a Multi Filter Support feature for fluorescence imaging that lets you
acquire a cube while employing two or more excitation/emission filter sets. For example, if multiple
fluorophores are used on a single specimen, and these fluorophores require widely differing
excitation wavelengths, then more than one excitation/emission filter set may be required to collect
the desired image data.
Note:

There is no need to select and use the Multi Filter Support option when acquiring image
cubes that require a single filter set.

While different exposure times can be assigned to each filter set in a multi-filter acquisition, the
region of interest, binning, bit depth, and gain must be the same for all filter sets. Any changes you
make to these parameters apply to all the filter sets you have selected.

To configure multiple filter sets:
1. Click the Add button in the Multi Filter Support group. When the Add Filter dialog box
appears, select a filter set to add. Click OK to add the filter set to the list of acquisition filters.
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Figure 22: Multiple Filter Support

2. If you want to employ a third filter setting, click the Add button again and select the third filter
setting to add to the acquisition list. Repeat this process for each filter you want to use for the
multi filter acquisition.
If you want to remove a filter setting from the list, select it in the Multi Acq drop down box
and click the Remove button. The remaining filters will move up in the sequence.
If you want to autoexpose or acquire a cube using just one of the filter settings in your multi
acquisition list, select the letter of the filter you want to use (“A,” “B,”, etc.) and clear the
Multi Acq check box. The selected filter will be used. (See also Saving Many Filter
Protocols in One Nuance Protocol 51 .)
3. Save this protocol if it will be used again later (see Saving Protocols
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).

4. When you are ready to autoexpose or acquire the cube using multiple filters, select the Multi
Acq check box. During multi-filter cube autoexposure and acquisition, the Nuance system
pauses during the operation and prompts you to install the next filter set in the sequence
according to the filter line-up you created.

Saving Many Filter Protocols in One Nuance Protocol
You can use the Multi Filter Support feature to save multiple filter protocols in a single Nuance
protocol. This is useful when you need to take multiple cubes of a specimen using different filter
sets. For example, you may want to take separate cubes of the same mouse using blue, yellow,
and red filter sets. (Remember, each filter set can have a different exposure time, but all sets will
have the same camera ROI, binning, bit depth, and gain.)
Follow the instructions earlier in this section to configure the filter settings (blue, yellow, and red, for
example) in the multi acquisition list, and then save the protocol. When you are ready to take
multiple cubes of a specimen, load the saved multi-filter protocol that contains the appropriate filter
sets. Choose the filter set you want to use to acquire the cube, and then clear the Multi Acq check
box so only the selected filter set will be used.

Taking a Reference Image for Flat Fielding
Flat Fielding makes it possible for the Nuance software to create better, more evenly bright mono
images and image cubes in fluorescence. If you acquire fluorescence images or cubes without Flat
Fielding, you may notice that the outer edges of acquired images are slightly darker than the rest of
the image.
Before acquiring a mono image or spectral cube, acquire a reference—or background—image. This
requires a fluorescence sample slide that is evenly bright across the field of view. Once you have
taken a reference image, it will be saved with the current Nuance protocol, if you save the protocol.

Brightfield and Fluorescence Imaging

51

Note that if you change the binning or region of interest (ROI), the current reference image becomes
invalid. You will have to take a new reference image before acquiring an image or cube with new
binning or ROI.
1. Select the Flat Field check box. This activates the Acquire Ref. Image button and disables
the Acquire Mono and Acquire Cube buttons until you acquire the reference image.

Figure 23: Flat Fielding

2. Replace the specimen with a plastic fluorescent slide (not included).
3. Click the Acquire Ref. Image button. (If you have activated multi-filter support, you will be
prompted to install the correct filter set(s) before continuing.)
4. After acquiring the reference image, move the specimen back into position.

Acquiring a Fluorescence Image Cube
1. Click the Autoexpose Cube button to autoexpose the cube (see Adjusting the Exposure Time
(Autoexpose) 46 .
2. Click the Acquire Cube button.
3. When the Nuance system has completed taking the image cube, a color representation of the
cube now in memory displays in the image gallery.
4. If you intend to save this cube, save it now as described in Saving Images and Image Cubes
Tip:
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When you are finished taking image cubes, remember to close the microscope’s
fluorescence shutter to avoid photo-bleaching the specimen.

5.12 Acquiring a Mono Image (Snapshot)
To take a snapshot of the current live image at the current wavelength and exposure, click the Acquire
Mono button. This function acquires a single picture, not an image cube.

5.13 Assigning Sample IDs and Notes
Assigning a Sample ID to an Image Cube
Use the Sample ID text box to assign an ID to the current cube. When you save the cube, it will be
saved with its sample ID. All measurements derived from the cube’s component images will be
saved with the cube’s sample ID.
Cube IDs display in the Cube ID column of the Measurements page near the bottom of the Nuance
work area.
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Saving Notes with an Image Cube
Use the Notes text box to save notes with the current cube. Whenever the cube is opened, any
notes previously saved with the cube will display in the Notes box.

5.14 Acquiring Timed Sequences of Image Cubes
The Nuance system can acquire multiple cubes of a specimen using a timed acquisition interval that you
specify. This is useful for observing changes in a specimen over a specified time span, generally no
longer than thirty minutes to one hour.
1. Select Tools > Acquire Time Sequence. The Acquire Time Sequence dialog box opens.
2. Enter the amount of time (in seconds) that you want to elapse between the start of each cube
acquisition. For example, if you enter 60 seconds and it takes 15 seconds to acquire the first
cube, there will be a 45 second time lapse until the start of the next cube acquisition. Be sure to
enter a time that is greater than the amount of time it will take to acquire each cube.

Figure 24: Acquire Time Sequence

3. Enter the number of cubes you want to acquire during this acquisition sequence.
4. Click the Browse button to select a destination directory where you want the Nuance software
to save all the cubes acquired during the sequence.
5. Enter a base filename for all the saved cubes.
6. Click the Acquire Cubes button to begin the acquisition sequence. A progress indicator
displays the amount of time until the next exposure (cube), the current exposure (cube) number,
and the total time remaining until the acquisition sequence is complete.
7. The Nuance software automatically saves each cube in the specified directory.
8. When the acquisition sequence is complete, you can locate the cubes at the destination
directory and open them in Nuance. As seen in the figure below, the cube filenames begin with
the base name you specified and include the date and time of acquisition.
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Figure 25: Cub es acquired during timed acquisition

5.15 Saving Images and Image Cubes
Devise a consistent naming convention for your images and image cubes. Use file and folder names that
incorporate specimen names as well as dates and/or times and acquisition parameters such as filter
cube, binning and exposure.

Saving an Image Cube
A PerkinElmer cube can include hardware settings, spectral libraries, user comments, and display
settings. (PerkinElmer format image cubes cannot be opened using third-party tools.)
1. To save the current image(s) and associated data, click the Save Cube button on the toolbar,
or select File > Save Cube. The Choose Cube dialog box opens.
2. Navigate to where you want to save the cube.
3. In the Save as type box, select a cube type option:
Select “Image Cubes” if you want to save the cube as a PerkinElmer image cube. A
PerkinElmer cube includes hardware settings, spectral libraries, user comments, and display
settings. Cubes saved in the PerkinElmer format cannot be opened in third-party tools.
Select “Image Cubes (with Lossless Compression)” if you want to save the cube as a
compressed or “zipped” file. Lossless compression saves disk space but also takes longer
to save the cube.
Select “TIFF Cubes” if you want to save the cube as a series of TIFF images. Nuance saves
a TIFF image in the specified location for each of the wavelengths used to acquire the cube.
When saving a cube that was acquired using multiple filters, filename_A_* will be used for
the first filter set, filename_B_* will be used for the second filter set, and so on. TIFF Cubes
contain only images; none of the associated data or settings is saved with this format.
4. Enter a file name for the cube and click the Save button.

Saving Images
1. Select File > Save Image and select a save option to save the image(s):
Save (As Displayed) prompts you to enter a name for the currently selected image, and
saves the image as a TIFF or JPEG image.
Save All (As Displayed) prompts you to enter a name for each of the current images in the
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image gallery, and saves the images as TIFF or JPEG images.
Note: When you save images “as displayed,” the Nuance software saves the images as
bitmap files. You cannot subsequently perform any sophisticated image processing
operations on the bitmap files, since the underlying data is no longer present. Saved
(as displayed) processed images can be opened in other third-party programs for
morphology operations such as determining area, shapes, or for counting objects.
As an alternative, you could export data as a series of TIFF files and open them in a
program that can handle wavelength sequential image files.
Save Image (As Unscaled Data) prompts you to enter a name for the currently selected
component image, and saves unscaled image data as a TIFF component with the data
values multiplied by 10.
Save All Images (As Unscaled Data) prompts you to enter a name for each of the
component images, and saves all unscaled image data as TIFF components with the data
values multiplied by 10.
2. When the dialog box opens, navigate to where you want to save the image(s). (The default
location is in C:\Nuance Data.)
3. Enter a file name and click the Save button.

Saving Image Cubes Automatically
The Nuance system can save your image cubes automatically.
1. Select Hardware > Edit Hardware Settings (or press Ctrl+H). Click the Autosave tab.
2. Select the Autosave Image Cubes option to enable the autosave fields.
3. To specify a default directory, click the Browse button and select from the browse dialog box.
4. Type a base name in the Base Name field, if desired.
5. In the Auto-naming Options group, specify a naming option. A sample appears in the File
Name box.
6. Click the OK button to save the changes and close the dialog box.

5.16 Viewing Cube Information
Cube information includes its size in pixels, the number of planes in the cube, a timestamp, any
comments associated with the cube, and the wavelengths and exposure times used to generate the
cube.
Right-click on the image in the Cube window and select Cube Info from the pop-up menu. The Cube
Info window opens.
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Figure 26: Cub e Information

5.17 Extracting an Image Plane from a Cube
You can extract and view individual wavelength images from a
cube.
1. Right-click on the image in the Cube window and
select Extract Channel from the pop-up menu.
2. Select the channel you want to extract by clicking a
wavelength value in the list. A monochrome image of the
selected wavelength opens in a new window.

Figure 27: Extract Channel
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6

Unmixing Spectral Images
Whenever possible, spectral processing—or unmixing—of cubes should be done using established
Nuance protocols. These are protocols that you have saved and validated with your Nuance multispectral
imaging system for each of your specimen/experiment types. In most cases, these protocols contain
spectral libraries that will be used when unmixing images (as explained in the Method Development 31
topic).
This section explains how to create a spectral library and unmix an image cube using the spectral
processing functions on the Spectra panel. Once you have created your spectral library, save the
protocol and library for repeated use throughout the experiment with the same or similar specimens.

6.1

Tips for Accurate Unmixing
Don’t assume that the spectra you acquired from purified fluorescent dyes are the same as those
present in your sample. Case in point: A researcher recently measured quantum dot (q-dot)
spectra by smearing samples on a clean glass slide. When the spectra were measured for the
same q-dot species in-situ (i.e., on the sample after having gone through processing), the spectra
had shifted about 10 nanometers towards the blue part of the spectrum for at least 3 different
species. So, if at all possible, use in-situ spectra acquired from the specimen itself for the
unmixing.
Don’t try to unmix more than 3 or 4 similar things simultaneously, since the unmixing algorithm is
sensitive to the presence of noise, and more end-members lead to more inaccuracy.
Always design experiments to validate the unmixing procedure. Do single, double, and triple
labels and take quantitative measurements. As you add more species, the chance for error goes
up dramatically in all noisy, imperfect, situations. Use appropriate controls (irrelevant antibodies,
unstained specimens) and approach the system critically. Multispectral capabilities are valuable,
but can be misused if applied uncritically.
When unmixing the fluorescence signals of specimens that have multiple strong and different
autofluorescent species in addition to the signals of interest, it may be necessary to use more
than one autofluorescence spectrum. For example, you may need to add more than one
autofluorescence signal to the spectral library if—in addition to general tissue autofluorescence—
there is also specific collagen spectra, to prevent the collagen signal from inappropriately being
allocated to another channel.
Do not use the same general autofluorescence spectrum for different tissues, species of
organism, sex of organism, or any other variable that may influence the local biochemistry of the
specimen without checking its appropriateness. All of these factors will alter the autofluorescence
spectra. The best approach is to derive autofluorescence spectra from appropriate unstained
controls.

6.2

Opening a Spectral Library
If a spectral library has already been saved and validated for the type of specimen/cube you want to
unmix, use that library to unmix the cube. Or if an appropriate Nuance protocol is available, which should
include the spectral library, then load the protocol instead (see Acquiring Images Using a Saved Nuance
Protocol 43 ).
By using a saved protocol and/or spectral library on similar specimens to unmix and perform analyses
throughout an experiment, you don’t have to recreate a spectral library every time. This helps ensure
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consistency throughout the experiment. Protocols and spectral libraries can be opened before or after
loading an image cube.
Note:

Be aware that using a spectral library from one specimen on a specimen that contains
different fluorophores will lead to incorrect results.

1. Select File > Open Spectral Library (or press Ctrl+L). Select the location and filename of the
library and click Open. One of the following will occur:
If the current library is empty, the library you selected will open.
If a library is open already, the Import Spectra From Library dialog box opens for you to
select the spectra you want to import (see Importing Spectra Into a Library 36 ).
2. The color palette on the Spectra panel will be populated with the new spectra.
Tip:

6.3

You can also open a Nuance spectral library by double-clicking the library (*.csl) file in a
My Computer directory window. If Nuance is not already open, this action will open
Nuance with the selected library. Or you can drag and drop the library file into an open
Nuance window to open the library.

Opening an Image Cube
1. Click the Load Cube button on the toolbar, or select File > Open Cube (or press Ctrl+O).
2. In the Choose Cube dialog box, browse to the location where the image cube is saved.
If opening a PerkinElmer format (.im3) image cube, double-click the file to open it.
If opening a TIFF image cube, open the folder containing the images and double-click any
one of the TIFF image files to open the cube.
3. The cube will open, and a color representation of it opens in the Nuance image gallery.
Tip:

6.4

You can also open an image cube by double-clicking the cube (*.im3) file in a My
Computer directory window. If Nuance is not already open, this action will open Nuance
with the selected cube. Or you can drag and drop the cube (or multiple cubes) into an
open Nuance window to open the cube(s).

Computing and Unmixing Spectra Automatically
This section explains how to use the Real Component Analysis (RCA) feature to unmix a fluorescence
image cube. This feature is intended for fluorescence unmixing operations and may not give consistent
or reliable results with brightfield datasets.
The RCA feature lets you explore how many different spectral features are present, extract spectra for
further analysis, and calculate “pure” spectra even if autofluorescence is present.
In this section we will open and analyze a fluorescence image cube (included with the Nuance software)
of a kappa lambda tonsil specimen using the RCA feature. The green regions in the raw data represent
the signal from 605-nm quantum dots and the red regions represent the signal from 655-nm quantum
dots. There is a lot of green autofluorescence present, obscuring the pure signals.
Open the demonstration kappa lambda image cube (see Opening an Image Cube 58 ). The cube is
located in the Nuance sample data folder: C:\Nuance Data\Images\ Sample Data\. Double-click the
“k appa lambda tonsil 605 655.im3” file to open the cube.
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Computing Spectra Using Real Component Analysis
1. Select the Spectra tab and click the Real Component Analysis (RCA) button.
2. The RCA dialog box opens (see figure below).
3. If you want to select a smaller region of the image on which to perform the RCA computation,
click the Select Area button. Then use the mouse to draw a rectangular region on the Cube
image. If you don’t draw a region, the whole image will be used. Clicking the Clear Area button
clears any user selected area from the image.
In the kappa lambda example, use the entire image in the computation (do not draw a box).
4. If you want to provide an initial guess of the background (autofluorescence) signal, click the
Select Area button. Then use the mouse pointer to specify the background signal in the image
cube.
In the kappa lambda example, leave this option un-checked.
This option also lets you import a known background spectrum from the current library by
selecting from the drop down box in the Starting Spectrum group. Use this option if there
is no region in the current sample that contains only autofluorescence.
These settings can be discarded by un-checking the Use Selected Background box.
5. Click the Find Component Images button to find the purest spectral features in the image. A
set of monochrome images of spectrally distinct signals will soon appear at the right of the cube
display window (see figure below). The number of images reflects the spectral complexity of the
sample.
6. Select component images for use in unmixing by clicking on them. Click an image once for
“Signal” and twice for “Background.”
If autofluorescence (or other background signal) is present, designate the autofluorescence
image (typically the top-left) as “Background” by clicking on it twice. Only one image can be
designated as background.
In the kappa lambda example, select the image in the top left as the background and set its
color to Black to hide the background signal in the unmixed image. (If you want to see the
background autofluorescence after unmixing, you can choose a pastel color such as Pink or
White, but this will cause a lack of contrast in the unmixed composite image.)
Note:

If you were unmixing a brightfield image cube and you wanted to hide a signal (such as
the background) from the unmixed composite image, unmix into white the signal that you
want to hide.
Look for other images that appear to contain “significant” signals (a sample-specific
judgement) by comparing the RCA images to the original image. Specific images should
match specific signals in the original image. Click once on images to designate them as
“Signals,” and select a color to represent each signal.
In the kappa lambda example, select the image that matches the 605 nm quantum dots in
the original image and set its color to Red. Repeat for the image that matches the 655 nm
quantum dots and set its color to Green. You may ignore the other images.
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Figure 28: Real Component Analysis

7. Click the Find Spectra button in the Computed Spectra group.
If no Background component was selected, then the “purest” spectra present in the cube
will be found.
If a Background component was selected, then all other signals will be used as inputs into a
computation that removes the presence of the background spectrum to give the spectrally
“pure” components.
8. The computed spectra should look like simple gaussian curves, which is the shape of accurate
quantum dot spectra. Occasionally, for weak signals, there may be too much baseline offset in
the data. Try selecting the Fit Offset option and clicking the Find Spectra button again and see
if the results improve.
9. You may now use the controls in the Computed Spectra group to change a spectrum's name,
color, and where it should reside in the spectral library.
10. When finished, click the Transfer to Library button to add the spectra to the main spectral
library. If a library is open already, you may be asked if you want to overwrite the existing
spectra.
11. Click the Close button to close the RCA dialog box.
12. When you are ready to unmix the image, first verify that the spectra you want to unmix is
selected in the library, then click the Unmix button.
Alternately, you may press the Transfer to Library, Unmix and Close button to perform all
these actions with a single click.
13. If the spectral library you have created will be used again for future unmixing operations, save
the protocol and/or spectral library.
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Unmixed Signals

6.5

Computing and Unmixing Spectra Manually
You can compute pure spectra without using RCA by
sampling the known and mixed spectra manually. Use the
color palette on the Spectra panel to build your spectral
library. Select colors for separating mixed signals into pure
signals.
If the cube you want to unmix was acquired using multiple
filters and overlapping acquisition wavelengths (see
Acquisition Setup Using Multiple Filters 50 ), you will notice
that there are two or more overlapping curves in the spectral
graph for each of the spectra in cube. Although this may
look unusual, the overlapping curves are used together as
one spectrum for all unmixing.
There are ten rows available that you can use to build a
spectral library. Be careful not to use the same color for
more than one signal.
Figure 29: Color Palette
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To sample spectra:
1. Open or acquire a cube and select the Spectra tab.
2. Click the Draw button within the row where you want to place the sampled spectrum.
3. Click and draw a line on the part of the cube you want to sample. (Holding down the Control or
Shift key will add additional regions to the sample.) When you release the mouse button, a
check-mark appears in the Select column.
Tip:

The Control and Shift keys also let you sample multiple cubes: Sample the current cube,
then select another cube from the thumbnails and hold down the Shift or Control key while
sampling to obtain an average of the spectra from the cubes.)

4. The default line sampling tool can be changed by selecting another region of interest shape from
the toolbar (see Selecting a Region of Interest Shape 62 ).
5. Assign a helpful name to each spectrum in the Name column.
6. To change the color assigned to a spectrum, select from its drop down color menu.

To hide a signal (e.g., background) in an unmixed image:
Unmix the signal you want to hide (such as the background) into black.

To clear the spectral library:
Click the Clear All button. This clears all spectra from the library, clears all spectral curves from the
Spectral Scale, and restores the default colors.

To restore default or saved colors:
Click the Restore Defaults button. This restores the color selection for each row in the library to the
default or last saved color.

To add notes to the current spectral library:
Enter notes for the current library in the Notes box. Notes will be saved with the spectral library
when you save the library.

Selecting a Region of Interest Shape
1. Click the Draw button for the row where you want to place the sampled spectrum.
2. Click the ROI button on the toolbar for the shape you want to use.
3. Click and drag over the part of the cube you want to sample.
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Manually Computing Spectra
1. Open or acquire a cube and select the
Spectra tab.
2. After loading or building a spectral
library, press the Manual Compute
Spectra button to display the dialog
box.
3. In the Known Spectrum group, select
the known spectrum—the spectrum of
the autofluorescence. Multiple known
spectra may be selected by holding
down the Control key while making
selections.
4. In the Mixed Spectrum group select
the spectrum that represents the
selected known spectra plus any
additional spectrum. For example,
autofluorescence plus a label.
5. The Computed Spectrum will be
displayed in the color specified at the
bottom of the dialog box.
6. If necessary, use the Scale functions to
fine-tune the fit adjustment. See Using
Fit Offset 64 and Error Scaling When
Manually Computing Spectra 63 for
instructions.
7. Select the row, name, and color for this
spectrum and press the Transfer To
Library button.
8. Repeat this process for the other mixed
spectra.
9. When you are ready to unmix the cube,
close this dialog box and click the
Unmix button on the Spectra tab.

Figure 30: Manual Compute Spectra

10. Save the new spectral library as
described in the Saving Spectral
Libraries 35 topic.

Error Scaling When Manually Computing Spectra
To obtain an accurate pure label spectrum (which is required for an accurate unmixing), the correct
amount of autofluorescence must be subtracted from the mixed spectrum. To do this, it is important

Unmixing Spectral Images

63

that the non-overlapping regions between the “pure” fluorophore and the autofluorescence line up
closely.
The Nuance software attempts to determine the amount of autofluorescence to subtract
automatically. When there is a bright fluorophore signal (relative to the autofluorescence), scaling is
usually not needed. In that case, clear the Scaling check box so that Nuance will subtract the
known spectra from the mixed spectra without any scaling.
When there is a weaker signal, you can scale the amount of autofluorescence that will get
subtracted from it to ensure that the best “pure” spectrum is found. This is done by checking the
Scale check box and sliding the Error Scaler slider.
1. In the Computed Spectrum group, select “Scale To Max” in the Scaling drop down box. This
provides the best visual representation of the spectra.
2. The mixed spectrum and computed spectrum are shown in their respective colors. The dotted
“best fit” line is a scaled representation of the known autofluorescence signal (see figure above).
3. With the Scaling box checked, try sliding the Error Scaler to the right to increase the scaling
(or to the left to decrease it) until the non-overlapping portions of the known and mixed spectra
line up as closely as possible (as shown in the figure above).
4. When you are satisfied with the computed spectrum, select a Spectrum Number, Name, and
Color and click the Transfer to Library button.
5. When you are finished adding spectra to the library, remember to save it as described in Saving
Spectral Libraries 35 .

Using Fit Offset
Occasionally, for weak signals, there may be too much baseline offset in the data. If you did not get
the desired unmixing results, select the Fit Offset option in the Manual Compute Spectra dialog
box and see if the unmixing results improve. The computed spectra (the plot in the Spectral Graph)
should have a simple gaussian curve.
When you are satisfied with the computed spectrum, select a Spectrum Number, Name, and Color
and click the Transfer to Library button. When you are finished adding spectra to the library,
remember to save it as described in Saving Spectral Libraries 35 .
This feature is also available when using Real Component Analysis, as explained in Computing and
Unmixing Spectra Automatically 58 .

Changing the Spectral Graph Scale
The Spectral Graph displays the spectral curves of selected pixels, as well as computed values for
unmixed signals. When you move the mouse pointer over the cube, the spectra associated with
each pixel appear as a white line on the Spectral Graph.
There are two places where you can select a scale for the Spectral Graph: at the top of the Spectra
panel and on the Manual Compute Spectra dialog box.
1. Select an option from the Scaling drop down box above the spectral graph:

64

Nuance Multispectral Imaging System

Select the “Normalized” option to view the spectral curves as normalized. The Y-axis in the
spectral graph is scaled 0 to 1. Each spectral curve is independently scaled to 1 at its
maximum height.
Select the “Scale To Max” option to scale the Y-axis in the spectral graph from 0 to
maximum height of the highest spectral curve in the image cube.
Select the “Un-Normalized” option to view the spectral curves as un-normalized. The Y-axis
in the spectral graph is scaled 0 to 255 (8-bit) or 0 to 4095 (12-bit).

Figure 31: Spectral Graph
Scaling Selector

2. Move the cursor over the image to see how the white curve changes shape. You are seeing the
spectral curve associated with each pixel as you move the mouse pointer.

6.6

Saving an Unmixed Result Set
After unmixing an image, you can save all unmixing results without having to save each unmixed image
independently. The Save Result Set feature saves the entire workspace (excluding the cube) in a single
file. This file will contain the component and composite image, the file name of the cube (but not the
cube itself), an RGB representation of the cube, and other data such as measurements and regions,
display parameters, user notes, and the spectral library.
You can then reload the saved result set later to review the unmixed results and conduct further
analysis/quantitation. You cannot do additional unmixing, however, because there is no cube associated
with a saved result set, unless you import the associated cube into the result set (see Importing a Cube
Into a Result Set 66 ).
1. With the unmixed images on your screen, select File > Save Result Set.
2. The Choose Results Set dialog box opens.
3. Enter a name for the new result set and click Save. Result set files are saved with a “.umx” file
name extension.

6.7

Working With Saved Result Sets
If unmixed result sets have been saved, you can open them for further analysis and quantitation. (See
Saving An Unmixed Result Set 65 for instructions on saving unmixed result sets.)

Opening a Result Set
1. Select File > Open Result Set.
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2. In the Choose Results Set dialog box, locate and select the “result_set.umx” file you want to
open, and click Open.
Tip:

You can also open a Nuance result set by double-clicking the result set (.umx) file in a
My Computer directory window. If Nuance is not already open, this action will open
Nuance with the selected result set. You can also drag and drop a result set into an open
Nuance window.

3. The unmixed images will open in the image gallery. If the Nuance software can locate the cube
associated with the result set (it must be a PerkinElmer format “.im3” Image Cube in its original
location on the computer), the cube will open along with its unmixed images. If the Nuance
software cannot find the cube or it is a TIFF Cube, an RGB representation of the cube (labeled
“RGB - Cube Is Not Loaded”) will open.
4. If the cube did not load automatically, you can import the cube into the result set. See Importing
a Cube Into a Result Set 66 for instructions.

Importing a Cube Into a Result Set
When a result set is saved, the original image cube is not saved as part of the result set (.umx) file.
An RGB representation of the cube is saved instead. When you open a result set, the Nuance
software attempts to open the associated cube as well. If the associated cube cannot be found, the
RGB proxy opens instead. You can replace the RGB proxy with the actual cube.
1. Right-click on the RGB image and select Import Cube from the pop-up menu.
2. The Choose Cube dialog box opens.
3. Select the cube (an Image Cube or TIFF Cube) you want to import and click Open.

6.8

Checking Your Spectral Library
Viewing Error Images
The Nuance software unmixes a cube’s spectral signals based on the spectra in your current library.
The Error Images utility in Nuance saves and can display any signals that are not accounted for in
the component images. Those signals are thus omitted from the composite image. In other words,
the Error Images contain all signals that would be left over if a cube could be recreated from the
unmixed component images.
After unmixing, select Tools > Show Error Images. Two new images (Error Cube and Error
Magnitudes) appear. The Error Cube contains the spectral variations of the error, while the Error
Magnitudes image contains the error energy (not actually energy) not present in the component
images. These images should contain no bright signals, but only “background noise” in the region(s)
of interest. If bright signals are present, this indicates that the cube was not optimally unmixed.
Use this utility to validate your spectral library and identify spectral features that are not being
accounted for in your unmixing. If you missed a spectral feature that needs to be in your library, the
Error Images show you where to look for that spectral feature. Add it to your library using Compute
Pure Spectra. Unmix the cube again using your improved spectral library.
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6.9

Subtracting Spectra from a Cube
The Baseline Subtract utility can be used to subtract a spectrum from a cube. For example:
In fluorescence, if there is stray light (background) in a cube, which contributes to a baseline
offset, use this utility to subtract the background from the cube and improve contrast. This will
ensure that the background is near zero (little or no offset).
In OD-converted brightfield images, use baseline subtraction to remove unwanted signals such as
excess chromogen or counterstain.
Baseline subtraction is done numerically (without scaling or other changes in value), wavelength-bywavelength, from every pixel of the cube. This alters the spectral shape of remaining signals and their
overall intensity. The magnitude of these changes depends on the intensity of the spectral signal being
subtracted. Typically, when background spectra are small compared to the signals, spectral library
entries derived from unsubtracted datasets can still be used, but this should be validated when
quantitative results are required.
1. Select Tools > Baseline Subtract. The Baseline Subtract dialog box opens.

Figure 32: Baseline Sub tract

2. This dialog box displays the spectra from the current spectral library.
3. Select spectra you want to subtract and click the Subtract from Current Cube button.
4. The Nuance software subtracts the selected spectrum from the cube and closes the dialog box.
The cube’s filename is also appended with “_subt” to remind you that a spectrum has been
subtracted from the cube.

6.10 Using Line Profiles to Analyze Signals
The Line Profiles tool can be used to analyze any single-channel (monochrome) image, including
component images and live images in Nuance. (Cubes and composite images cannot be analyzed with
the Line Profiles tool). To use this tool, draw lines on the component images. The pixels sampled by the
line show up as a plot of intensity versus pixel count in the Spectral Graph of the Line Profiles dialog
box.
1. Select or open the monochrome image (or images) in the Nuance image gallery.
2. Select Tools > Line Profiles. The Line Profiles dialog box opens.
Ten rows in the color library allow you to draw up to ten profile lines on multiple
monochrome images.
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Each line profile appears as a plot with corresponding pen color in the Spectral Graph.
You can change the Spectral Graph Scale to either “Normalized” or “Scale To Max.”
The Clear All button is used to remove all profile lines from the image(s) and clear the
Spectral Graph.
3. To draw a profile line, click the Draw
button on the first row (Red) of the color library, and
then use the mouse pointer to click and draw a line across the area of interest in the image. As
you draw a line within the image, the Spectral Graph displays the intensity of the selected
pixels.
4. This figure shows two profile lines drawn on a component image. These lines show the variation
in the amount of 655 nm Qdot™ present in the cells sampled by the lines.

Figure 33: Line Profiles drawn on component images

Move the mouse pointer across the Spectral Graph in the Line Profiles dialog box. You will notice a
black dot appear on each line. These dots correspond with the dots on the profile lines of the images.
They can help identify specific pixel intensities on the line and in the spectral graph.
The Line Profiles tool is for data comparison purposes only. The ability to export profile data has not yet
been enabled.

Working with Line Profiles
After drawing line profiles on an image, you can copy, clone, move, and delete lines by right-clicking
on them.

68

Nuance Multispectral Imaging System

To copy line profiles to the clipboard:
1. Right-click on the image that contains the lines you want to copy, and then select Copy Line
Profiles To Clipboard from the pop-up menu. This feature copies all profile lines in the image
onto the clipboard. If you want to copy a single line to another image, simply drag and drop the
line onto the other image. (Be sure to deselect the Draw
tool before attempting to drag and
drop the line.)
Note:

When dragging a copy of a line to another image, the line will not move while you drag the
mouse pointer. However, the copy will appear on the new image, at the same spatial
coordinates as the original copy, when you release the mouse button at the destination.

2. Right-click inside the image to which you want to paste the line profiles and select Paste Line
Profiles From Clipboard.
3. All line profiles on the clipboard are pasted into the current image. Each new line profile is
assigned the next row/color in the color library, and all lines are plotted in the Spectral Graph.

To clone a line profile:
1. Right-click on the line you want to clone and select Clone Line Profile from the pop-up menu.
(Cloning creates an exact copy of the original that you can move to another area within the
current image. You cannot move a clone to another image.)
2. The mouse pointer changes to a hand with a floating clone of the original line attached to it.
Move the clone and click to release it at the desired location.

To move a line profile:
1. Right-click on the line you want to move and select Move Line Profile from the pop-up menu.
2. The mouse pointer changes to a hand with the floating line attached to it. Move the line and
click to release it at the desired location.

To delete a line profile:
1. Right-click on the line you want to delete and select Delete Line Profile from the pop-up
menu.
2. The line is removed from the image, the selection is removed from the color library, and the
profile plot is removed from the Spectral Graph.

6.11 Comparing Multiple Images
The Compare Images tool lets you compare greyscale images from a single cube or from cubes
collected over time so that you can more easily visualize differences in intensity in the component
images. Images compared with this tool do not need to have the same scaling or image display
parameters. Compare Images will display images on the same scale, accounting for differences in
intensity due to bit-depth, exposure time and binning.
The datasets in the following example illustrate dynamic range variability of different signals and how
they can be compared using the Compare Images Tool.
1. Open and unmix the relevant cubes so that their component thumbnails are listed in the
Thumbnails list at the bottom of the window.
2. Select Tools > Compare Images. The Compare Images dialog box opens (see figure below).
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3. From the image gallery or the Thumbnails list, drag the greyscale component images to be
compared onto the display boxes in the dialog box. (You may need to scroll the Thumbnails list
to locate all your greyscale images.)
4. By default, the dialog box has room to compare 16 images. You can use the scroll boxes in the
Grid Dimensions group to change the display grid. While it is possible to compare more than
16 images, this is limited by the available amount of computer memory. Try using the Close all
windows (including thumbs) command in Nuance, and close other applications that may be
running before trying to open additional images.
5. All images are scaled based on the image with the brightest signal. As you can see in the figure
below, the Display Key for the upper-left image, which contains autofluorescence, has the
brightest signal with 786 counts. The red outline in each image Display Key indicates the
display range of the individual image.
6. The other images contain the two other fluorophores in the same sample. Both fluorophores are
much weaker than the autofluorescence.

Figure 34: Compare Images

7. If an image you are trying to compare is either too dark or too bright to display any visible detail
at the display range of the other images, use its Scale Factor multiplier to multiply its pixel
intensity.
In the above figure, the upper-right image is only half as bright (~ 400 counts) as the
autofluorescence. Increasing its Scale Factor to 2x (see figure below) makes the image
brighter (notice also the change in its Display Key).
The lower-left image is completely dark. It is only one-eighth (~ 100 counts) as bright as the
autofluorescence image. Increasing its Scale Factor to 10x makes the image brighter to
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match the other images

Figure 35: Compare Images using different scaling factors and the “Jet” color map

Modifying Display Settings
The Display Mapping options are used to adjust the brightness and contrast of all the images
together.
The Color Map drop down box lets you map the display to a variety of pseudo colors. The
example in this figure is shown using the “Jet” color map.
The Saturation Mask option allows you to mask saturated pixels if desired.

Zooming and Panning Images
Right-click on any of the images and select Zoom from the pop-up menu. The pointer changes to
a magnifying glass. Use the magnifying glass to draw a box around the area you want to zoom.
To pan zoomed images, right-click on any image and select Pan. You can now drag the image to
the region you want to view.
When you want to return to the full image, right-click any image and select Zoom To Full Image
.
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Saving Displayed Images
To save a copy of an image with its current display settings, right-click on the image and select an
option from the pop-up menu:
Save Image As Displayed opens a Choose RGB File dialog box where you can save the image
(as it is displayed) in TIF or JPG format.
Copy Whole Image To Clipboard copies the entire image, regardless of the current zoom level,
to the clipboard. This can then be pasted into a third party software program.
Copy Displayed Image To Clipboard copies the current viewable region of the image to the
clipboard. This can then be pasted into a third party software program.

6.12 Processing a Batch of Cubes
In some instances, you might prefer to acquire a large number of cubes before analyzing them, or you
might want to re-analyze a set of images with new analysis settings. The Batch Data Processing feature
is useful for unmixing and measuring multiple cubes or a large set of images all at once. It can also be
used to perform co-localization staining detection on a batch of cubes.
1. Select Tools > Batch from the main menu. The Batch Data Processing dialog box opens.

Figure 36: Batch Data Processing

2. If the spectral library you want to use is open already, its spectra will display in the color library.
You can add spectra to the library or open a new one by clicking the Load button.
3. Use the check box(es) in the Select column to select the spectra you want to use for unmixing.
Use the Measure column to select the unmixed component images that you want to measure
during batch processing.
4. The Apply Baseline Subtraction check box offers the same functionality as the Baseline
Subtraction 67 feature. If there is stray light (which contributes to a baseline offset) it can be
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subtracted from the batch of cubes using this option. Select this check box, then indicate which
spectrum to subtract from all cubes.
5. The Convert to OD check box lets you convert all of the cubes in the batch to Optical Density.
This function automatically uses spectrum 10 to convert all cubes to OD, so your background
spectra must be assigned to spectrum 10.
6. The Choose Cubes group lets you select the image cubes you want to include for batch
processing.
a.

Click the Find Candidate Cubes button below the list.

b. Select a folder from the dialog box and click OK. The Nuance software will search this folder
and its subfolders for cubes that are compatible with the current spectral library and display
them in the Candidate Cubes list.
c. Select the cubes you want to process, and click the Add button. This will add them to the
Selected Cubes list on the right.
7. The Measurement Options group lets you select the measurement parameters that will be
used in the batch processing. Use the radio buttons to select one of the following options:
No measurements (Unmix only) – This option unmixes the selected cubes.
Auto Threshold – If you select this option, then specify the Min. Connected Pixels
parameter and choose at least one component image to measure. (Select from the
Measure column in the spectral library.) Also, browse to specify a Global Measure File to
contain all of the exported measurement results.
Manual Threshold – If you select this option, then specify both the Threshold and Min.
Connected Pixels parameters. Next, choose at least one component image to measure.
Browse to specify a Global Measure File to contain all of the exported measurement
results.
Use Precalculated regions – If you select this option, select a Regions (.roi) file and/or a
Measurements (.txt) file that you want to use to measure the unmixed results.
8. If you want to run co-localization detection on a batch of cubes, check the Measure Colocalization check box. Notice the prompt to “Load settings compatible to the loaded spectral
library.” The spectral library used to unmix the candidate cubes must match the library
referenced in the co-localization settings file.
a. Click Load to load a co-localization settings (.col) file that was created and saved earlier
using one of the candidate cubes. See also Saving and Loading Co-localization Settings 95 .
b. Browse to specify a Measure File to contain all of the exported co-localization
measurement results.
9. The parameters in the Save Options group control which file types are saved and how the files
are named. Results are saved in the same directory as the cube.
The File Suffix parameter defines the suffix that you want added (such as the date,
operator’s initials, etc.) to the file name of each saved file. The unmixed results will be
named “originalcubename_filesuffix.umx”. If you do not specify a suffix, none will be added
to result set file names. Measurements files are saved with a date_timestamp_measures.txt
filename.
Under Save Files, select any or all of the following:
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o

Unmixed result sets saves each unmixed result set as a result set (.umx) file.

o

Component images saves a separate data file (.tif) for each unmixed component
image.

o

Co-localization images saves a co-localization image (.jpg) for each cube.

10. Click the Run Batch button. This will iterate through the selected cubes, unmix them, measure
any components selected for measurement, and run co-localization detection if selected. A
Batch Mode Progress box displays the estimated time remaining until completion.
11. When the batch process is complete, you can open an explorer window of the cube directory to
view the exported files. For example, the ki67-20x(1Aug2008)OD candidate cube shown in the
figure above resulted in the following exported files:
The exported Co-localization image file was saved as
ki67-20x(1Aug2008)OD_coloc_8-15-08-EJS.jpg
the exported Co-localization measurements file was saved as
ki67-coloc-measurements.txt
The exported Measurements file was saved as
8-15-08-EJS_2008-Aug-15__09_39_43_measures.txt
The exported Component image (*.tif) files were saved as
ki67-20x(1Aug2008)OD_Pure DAB_8-15-08-EJS.tif_Data_x10000
ki67-20x(1Aug2008)OD_Pure Hematoxln_8-15-08-EJS.tif_Data_x10000
The exported Result set was saved as
ki67-20x(1Aug2008)OD_8-15-08-EJS.umx
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7

Quantifying Results
The Measure panel is used to draw measurement regions and set measurement parameters. The
Measurements page at the bottom of the Nuance work area displays the measurements of regions
drawn on component images. This section explains each of the tools used for measuring regions on
component images.

7.1

Measuring Regions
Finding Regions Automatically Using Threshold Segmentation
1. Select the component (or any other single-plane) image to be measured and make sure the
Measure panel is visible.
2. In the Threshold Segmentation group, click the Auto Calculate Threshold button. The
Nuance software will attempt to find a threshold level that is appropriate for the image.

Figure 37: Threshold Segmentation

3. Pixels with intensity values below the specified threshold are ignored. If you are not satisfied
with the auto calculated threshold level, you can enter a new value in the Threshold Level field
by using the slider or manually typing in a value. You will see the region(s) change as you edit
the threshold level.
4. After a threshold is set, the image will have an overlay showing the regions that were measured,
as shown in this figure.
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Figure 38: Measured Threshold Regions

5. If there are too many or too few measurement regions, adjust the Threshold Level or
Minimum Connected Pixels value (see Ignoring Smaller Regions 80 ).
6. You can adjust the region’s transparency or change its color (see Adjusting Region
Transparency and Color 80 ).

Manually Drawing and Modifying Regions
The Nuance software provides tools for manually drawing and modifying measurement regions.
These tools are located in the Manual Draw Regions group on the Measure panel:
1. Click the Draw button on the Measure panel.
2. Select the draw tool shape by selecting from the toolbar or right-clicking the image and
selecting from the pop-up menu (rectangle-, ellipse-, line-, or area-ROI).
3. Use the mouse pointer to draw new regions of the image to measure.
4. Each region is assigned an ROI number and is listed in the Measurements page at the bottom
of the screen. Measurement regions are numbered and sorted according to their size, with the
largest region first, and the smallest last.
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Figure 39: Manually Drawing a Region

5. The dashed lines drawn on top of each region show the region's major and minor axis drawn
through the center of gravity.

To erase part of a region:
1. Click the Erase button on the Measure panel.
2. Select the erase tool shape by selecting from the toolbar or right-clicking the image and
selecting from the pop-up menu (rectangle-, ellipse-, line-, or area-ROI).
3. Use the mouse pointer to remove pixels from existing regions.

To clear all regions:
Click the Clear button to remove all measurement regions.

To move or delete a region:
Right-click on the region you want to move or delete and select from the pop-up menu.

Cloning Regions
The Nuance software’s ability to clone regions makes it easy to directly compare control regions
and fluorophore regions of an image. Once you clone a region, you can then move the clone to
another area of the image to compare the fluorescence signals.
1. Right-click on the region you want to clone and select Clone Region from the pop-up menu. A
clone of the region is created.
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2. Move the clone to the desired area of the image. The clone will become the next sequentially
numbered measurement region.

Figure 40: Cloning a Region

Dragging a Copy of a Region to Another Image
You can drag a copy of a region from one component image to another. When you drag a region to
another image, the Nuance software automatically pastes the region at the exact same location in
the new image. This feature is useful for comparing regions across two or more composite images.
1. Click on the region you want to copy, and while holding down the mouse button, drag it to the
new image.
2. Release the mouse button anywhere in the new image. The copied region will automatically
snap into position, corresponding to the position of the original.

Copying all Regions to the Clipboard
The Nuance software can copy all existing regions from an image to the clipboard. You can then
paste the copied regions from the clipboard to other images. (All regions in the image are copied
with this feature. See Dragging a Copy of a Region to Another Image 78 if you want to copy a single
region.)
1. Right-click on the image that contains the regions you want to copy, and then select Copy
Measurement Regions To Clipboard from the pop-up menu.
2. Right-click inside the image to which you want to paste the regions and select Paste
Measurement Regions From Clipboard.
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3. All measurement regions on the clipboard are pasted into the current image. Each new region is
assigned a ROI number, and its measurement data displays in a new row of the Measurements
page at the bottom of the Nuance window.
4. The ROI numbers can change from image to image depending on what other regions are present
in each image.

Saving and Loading Regions
If you save your measurement regions, you can easily load them to other images. This is useful for
comparing control regions and fluorophore regions across multiple images.
1. Right-click anywhere on the image (but not within a region) and select Save Measurement
Regions from the pop-menu.
2. In the Choose Measurement Regions dialog box, enter a descriptive name, and click Save to
save the measurement region(s).

To load a region to an image:
1. Right-click anywhere on the image (but not within a region) and select Load Measurement
Regions from the pop-menu.
2. The region(s) will be loaded to their exact pixel location when they were saved. You can move
the region(s) by right-clicking them individually and selecting Move Region.

Obtaining Accurate Measurement Data
The Nuance software calculates each region’s area in pixels and in mm2 based on the current
binning selection on the Measure panel. This selection must be correct for the mm2 measurement
to be accurate.
For PerkinElmer format “Image Cubes,” the Nuance software automatically displays the binning
used to acquire the cube. This setting cannot be changed.
TIFF cubes do not save binning information. The binning value defaults to 1x1. For TIFF cubes, you
can change this value in case it was set incorrectly during cube acquisition.

Figure 41: Millimeters Per Pixel

To change the binning:
Make a component image active, and then select from the Binning drop down boxes. (Binning can
be changed for TIFF cubes only.) The Nuance software calculates and displays the new mm/Pixel
value automatically, based on the calibrated pixel size (see Calibrating Pixel Size 29 ).
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7.2

Ignoring Smaller Regions
The Measure Objects group on the Measure panel is used to specify a minimum region size based on
its number of pixels. Only regions that are larger than the Min. Connected Pixels value are considered.
The Nuance software ignores regions that have fewer than this number of pixels.

Figure 42: Minimum Connected Pixels

Use this control to change the size of the regions to filter out. This setting does not effect manual draw
regions.

Hiding Region Labels
Numbered region labels correspond to the ROI Numbers on the Measurements page at the bottom
of the Nuance work area. Sometimes a region label obscures important data or makes it difficult to
see the region clearly. You can have the Nuance software draw or hide numbered labels on regions
within an image.
A check-mark in the Draw Region Labels check box (see figure above) will show the region labels
that are normally drawn on top of the region. Clearing the check-mark hides these labels.

7.3

Adjusting Region Transparency and Color
1. Use the Transparency slider (see Threshold Segmentation 75 image) on the Measure panel to
change how much measurement regions block the image behind it. Moving this slider all the
way to the left makes the region transparent (except for its outline). Moving the slider all the way
to the left fills the region with the selected color.
2. If you want to change the transparency’s color, select a color from the Transparency Color
drop down box.

7.4

Understanding Region Measurements
Each region’s measurements are displayed as rows on the Measurements data page near the
bottom of the Nuance work area (see Measured Threshold Regions 75 figure). The following
information is displayed:
The Selected column indicates which measurement regions are displayed on the image. Clear
the check box from a measurement row to remove its region from the image.
The ROI Number for each measurement region corresponds to the number displayed in the
center of the region drawn on the image.
Cube ID is the ID entered in the Sample ID field on the Fluorescence panel when the cube was
acquired.
Average Signal is the average value of the pixels in the region.
Standard Deviation represents the variation of the signal values.
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Total Signal is the sum of all the pixel values in the region.
Max Signal is the maximum pixel value included in the region.
Area (Pixels) is the number of pixels included in the region.
Area (µm^2) is the size of the region in square microns. This measurement will only be displayed
if the camera’s pixel size has been calibrated (see Calibrating Pixel Size 29 ). Also, the accuracy
of this measurement depends on setting the correct binning (see Obtaining Accurate
Measurement Data 79 ).
Major Axis is the length of the minimum area bounding box enclosing the region.
Minor Axis is the width of the minimum area bounding box enclosing the region.
X Location is the center of gravity's x coordinate.
Y Location is the center of gravity's y coordinate.
Spectrum ID is the ID of the spectrum used to unmix this image (entered from the Spectra
panel).
Cube Time Stamp represents the time the cube was created.

Hiding Measurement Columns
Right-click anywhere within the measurement rows. The pop-up menu lists all columns with check
marks. Click any column to clear its check mark and hide the column from the display. Repeat for
all columns you want to hide. You can hide any or all columns except for the Selected and ROI
Number columns.

Copying Measurement Data to the Clipboard
1. Make sure the measurement regions you want to copy are selected on the Measurements data
page (check marks in the Selected column).
2. Click the Copy Measurements to Clipboard button in the Measure panel. Any columns you
have hidden will be omitted from the copied measurements.
3. You can now switch to a program such as Microsoft Excel and paste the measurements into a
worksheet.

Saving Measurement Data as a Text File
1. Make sure the measurement regions you want to save are selected on the Measurements data
page (check marks in the Selected column).
2. Select File > Save Measurements. The Choose Measurement File dialog box opens.
3. Select a location and enter a name for the text file. Click the Save button to save the new text
file. Any columns you have hidden will be omitted from the saved measurements.
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Appending Measurement Data
You can append new measurement data to end of an existing measurement data text file.
1. Make sure the measurement regions you want to append to a saved text file are selected on
the Measurements data page.
2. Select File > Append Measurements. The Choose Measurement File dialog box opens.
3. Select the file to which you want to append the measurement data and click the Save button.
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8

Customizing Spectral Displays
The topics in this section explain how to use the Display panel and the Display Control utility to adjust
display parameters of a cube, component image, or composite image to obtain a clearer view of the
image. The Display Control utility changes depending on the current image type.

8.1

Adjusting Brightness and Contrast Levels
The controls in the Display Mapping group on the Display panel are used to change brightness and
contrast levels within images.
Five sliders allow you to adjust the following:
o Brightness
o Contrast
o Brightness for the individual red, green, and blue color channels. These sliders are enabled only
when a cube or composite image is selected.

Figure 43: Display Mapping

The Min. Max. option maps the minimum value in the image to 0, the maximum value to 255, and
linearly interpolates in between those values. This stretches dark signals so they become visible.
The Clip/Stretch option maps the lowest 0.01% of the pixels to 0, the highest 0.01% to 255, and
linearly interpolates in between those values. This prevents a few bright or saturated pixels from
skewing the display.
The Histogram Eq. option maps the pixels so the histogram of the pixels have approximately the
same number of pixels in each bin. This gives the best display of the whole dynamic range of dim
and bright signals.
The Raw option applies no scaling to the data.
The Abundance option is enabled only when a composite image is selected. This option scales
all the pixels in a composite by the ratio of 255 and the value of the single brightest pixel among
all the components. This usually results in a brighter composite image.
Note:

In fluorescence images, the autofluorescent background signal is often the source of the
brightest pixels in the dataset. If this background signal was unmixed into black to make
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it seem to disappear, selecting the Abundance option may result in an almost all black
composite image. Unmix the background into white or other light color before applying
Abundance scaling.
The Enhance Contrast check box adjusts the display of the cube to compensate for the
brightness and contrast of your monitor.
The Custom check box lets you assign specific minimum and maximum clip values to the
display of any image. This check box works with the Min. Max. and Clip/Stretch display options
only. Increase the Min Clip value to exclude more of the lowest value pixels from the display.
Decrease the Max Clip value to exclude more of the highest value pixels.

8.2

Applying Overlays
Saturation Mask
Saturated pixels in your images reduce the accuracy of your unmixing and quantitation results. The
Nuance software considers a pixel in a cube “saturated” if the pixel is saturated at any of the cube’s
wavelengths. Pixels in a component image remain saturated if they were saturated in the cube used
to create the component. In a composite image, a pixel will be saturated if it was saturated in the
component image.
If saturation is present in your image, use the Saturation Mask controls on the Display panel to
reduce or eliminate the effects of the saturated pixels.
1. Select the image to which you want to apply the saturation mask.
2. Select the color that matches the saturated pixel color.
3. Click the Display check box to apply the saturation mask to the image.

Live Overlay
The Live Overlay option lets you use a saved image as an overlay on top of the live view for
positioning your specimen as when it was previously imaged. Open the image you want to use as
an overlay. Right-click on the image and select Set As Live Image Overlay from the pop-up menu.
The overlay is now visible in the live view. Use the Display check box on the Display panel to view
or hide the overlay. Use the Transparency slider to increase or decrease the transparency of the
overlay image.

8.3

Adjusting a Cube's RGB Mapping
Computers display color through varying intensities of red, green, and blue. To display an image cube,
which has many more color planes, the Nuance software maps all colors in the cube to the red, green,
and blue planes.
When a cube is the active image, the Wavelength to RGB Map group becomes visible in the Display
panel. Wavelength ranges in the image cube are mapped to red, green, or blue to create the display
image. The sample on the left displays for cubes that have not been converted to Optical Density (OD).
The sample on the right displays for OD cubes.
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(non-OD-Converted)

(OD-Converted)

Figure 44: Wavelength to RGB Map

The non-OD sample (left) has red, green, and blue bars. The wavelengths in the red bar are mapped to
the red plane in the display image (green to green, and blue to blue).
You can move these bars by clicking and dragging them. This will change the wavelength range that
gets mapped to that color plane. The bars can also be resized to increase or decrease its wavelength
range by dragging the handles on the ends of the bars.
You cannot change the wavelength mapping of OD cubes.
The plot below the bars shows the current spectral library. It also shows the spectrum underneath the
cursor when it is moved over the display cube. The x-axis represents the wavelength range of the cube.

To View Visual RGB
Click the Visual RGB button to set the bars so they approximate the human eye.

To View Equal RGB
Click the Equal RGB button to set the bars so they divide the cube’s wavelength range equally among
the red, green, and blue planes.

8.4

Changing Components in a Composite Image
The Nuance software displays a composite image by combining the displays—not the raw data—of the
component images. When a composite image is active, the Component Selection group becomes
visible in the Display panel.
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There is a row for each component image. Use the
Display column to control which components are used
to create the composite image. If you want to change
the color used to display any of the component images,
select a color from the component’s Color drop down
box.
This feature is very useful when you want to make the
fluorophore signal of interest more clearly visible in a
composite image. For example, you could exclude the
Background component (thereby removing the
autofluorescence) from the composite image. Doing this
in combination with adjusting the Brightness and
Contrast of the unmixed components (using the sliders
in the Display Mapping group), can result in a clear
bright image of the tumor, fluorophore, etc.

Figure 45: Component Selector

8.5

Advanced Display Controls
In addition to the tools available on the Display panel, the Display Control utility offers more
advanced functions for adjusting how cubes, composites, and components are displayed. The
functions that are available with this utility will vary depending on the kind of image that is currently
active.

Opening the Display Control Utility
Click the Display Control button on the toolbar. The top half of this dialog box offers an enhanced
version of the Display Mapping and Scaling selectors found on the Display panel (see Adjusting
Brightness and Contrast Levels 83 ). You can adjust the brightness and contrast of the image.

Linking the Contrast and Brightness Sliders
Check the Show Crosshairs check box above the preview image. This lets you drag the
intersection of these two sliders to any position on the image until the desired display is achieved.

Adjusting Composite Display Settings
Click on the composite to make it the active image. The bottom half of the Display Control utility
expands with a list of the component images and other display options such as coloring style and
blending style. These can be used to make the label signal of interest more clearly visible in the
composite image.
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For example, you could exclude the Background (thereby removing the autofluorescence) from the
composite. Doing this and using the sliders to adjust the brightness and contrast of the label signal
can result in a clear bright image of the specimen.

To include or exclude layers:
Click the layer’s View
composite.

button to include it, or its Hide

button to exclude it from the

To adjust a layer’s brightness or contrast:
Click the layer’s Adjust
button. Then use the Brightness and Contrast sliders to adjust the
display of the layer. (You can link these sliders by checking the Show Crosshairs check box.)

To view images in fluorescence or brightfield:
Use the Composite Coloring Style options. In general, you want to select the mode under which
the image cube was acquired.

Figure 46: Display Control

To create a composite image by blending its component signals:
Select Normal (Merged) in the Layer Blending Style group. This will blend the signals from each
of the components to create the composite.
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To create a composite image by overlaying its component signals:
Select Overlay (Thresholded) in the Layer Blending Style group. This will overlay each
component signal on top of the component signal(s) beneath it. When you select the Overlay
option, this also enables the Threshold Legend right-click menu item for composite images (see
Displaying the Intensity Legend 88 ).
The component at the bottom of the list is the base layer. You can change the order of any
component in the list by clicking the up or down arrow next to its thumbnail.
If you want to import a new component image as the base layer, click the Import Image button and
select the image you want to import. The imported image is added to the bottom of the components
list. The Nuance software creates a new composite called a “Layered Image” and displays it in the
image gallery.

Returning to the Default Display Setting
When viewing/editing a single layer, clicking the Reset Layer button returns all display settings for
the selected layer to the default state. When viewing/editing the whole image, clicking the Set To
Default button returns all values of all layers to their default state.

8.6

Displaying the Intensity Legend
For a composite image and any of its components, you can display a legend that represents minimum
and maximum intensity values within the image. (Images can be from any multispectral cube.)
To apply the legend to a component image, right-click the component and select Display Intensity
Legend from the pop-up menu. The legend displays in the lower right-hand corner of the image. For
components, the legend is always in grayscale. For a composite image, first open the Display Control
for the composite and select the Overlay (Threshold) layer blending style. Close the Display Control
and right-click on the composite to select Display Intensity Legend. For composites, the legend
always displays the color scheme selected for the first visible component listed in the Display Control.
The title of the legend—and the intensity values displayed—correspond with the Measurement Pixel
Units that were selected at the time the cube was acquired. (This selection is made from the Hardware
> Edit Hardware Settings > Preferences settings panel.) Intensity display possibilities include the
following:
“Raw Counts” (if the original cube was a TIFF stack), “Counts,” “Scaled Counts/Sec.” (see
Selecting a Measurement Pixel Unit/Scaling 28 for definitions).
If the title of the legend is “Optical Density,” this means the cube has been converted to optical
density.
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9

Macros
A macro is a shortcut for a sequence of actions. You assign the macro a name and save it. Later, when
you run the macro, the macro plays back as if you were performing the actions yourself. A macro can be
simple (for example, it could autoexpose and acquire a cube) or it can be complex. For example, it
might load a spectral library, pause for you to open a cube, unmix the cube, draw regions of interest,
prompt you to adjust the location of the ROIs, save the result set and export the ROI data.

9.1

Overview of the Macros Dialog Box
Choose Macros > Define Macro from the main menu to reveal the Macros dialog box (see figure
below). Each item in this dialog box is described below.
The Macros drop down box lets you select a macro to run. When you select a macro, its steps
display in the window. Saved macros cannot be modified. You can also select a macro to run
from the Macros drop down box on the status bar, at the bottom-right of the screen.
The Run Macro button runs the selected macro. This button is also available on the status bar at
the bottom-right of the screen.
The Pause Recording button places the macro recorder in pause mode. When the recorder is
paused, it does not record any of your actions. To start recording again, click the Continue Macro
button.
The Continue Macro button continues running the macro after a message and/or pause in the
macro that requests a user action. This button is also available on the status bar.
The Load button is used to import a macro (.rcd) file that contains recorded commands.
The Save button saves a new macro file of all the macros currently listed in the Macros drop
down box. Macros that you create are automatically added to the Macros list; however, they are
not permanently saved on the system until you click the Save button to save the new file. Any
new macros that are not saved will be lost when you close the Nuance software.
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Figure 47: Macros Dialog Box

The Record button starts the macro recorder. Once you click Record, most keystrokes mouse
clicks, and menu selections can be recorded as commands in the new macro.
The Stop button stops recording commands and ends the macro.
The Pause button places a pause in the macro to allow the user to perform actions that may be
required, such as creating a spectral library, acquiring a reference image, and so on. It is
recommended to add a Message to the macro immediately before a Pause so that the user
knows what action is required before continuing with the macro. The macro continues once the
user clicks the Continue Macro button.
The remaining buttons insert commands into the new macro:
The Load Files button adds a prompt requesting that the user select a file to load that will be
used in some way by subsequent macro commands. Before you click this button, use the Type
to Load drop down box to select a file type (i.e., cube, result set, protocol, spectral library,
image, or composite).
The Save Files button adds a prompt for the user specify autosave options for files being
generated or edited by the macro. Before clicking this button, use the Type to Save drop down
box to select a file type (i.e., cube, result set, protocol, spectral library).
The Loop button adds a loop command that controls the number of times to repeat the command
that follows it. First select the number of Times to Repeat, and then click the Loop button. Then
add the commands you want to repeat.
The Timer button inserts a timed delay into the macro. First select the Delay time in seconds,
and then click the Timer button.
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The Message button inserts a command to display a message to the user while running the
macro. You can enter any text message or insert an HTML formatted file. The macro will present
the message and wait for the user to acknowledge it before continuing the macro.
The End Loop button terminates the loop cycle if you started a loop earlier in the macro.

9.2

Running Macros
1. Make sure the image is focused and centered in the Live window first, before running a macro
that acquires a cube.
2. Select a macro from the Macros drop down box on the status bar. Or choose Macros > Define
Macros from the main menu and select the macro to run.
3. Click the Run Macro button. Follow the prompts—if any were created as part of the macro—to
proceed through the entire macro until it is finished.

9.3

Recording Macros
1. Choose Macros > Define Macros from the main menu to reveal the Macros dialog box.
2. Click the Record button to start recording commands. You can use the buttons in the dialog
box to load files, add command loops, and so on (as described in the Overview of the Macros
Dialog Box 89 topic). The recorder also records mouse clicks, menu selections, and other
actions while the recorder is running.
3. When you are finished recording, click the Stop button. You can then play back the new macro.

9.4

Saving Macros
1. Macros that you create are not saved permanently until you save them. Click the Save button.
Select a location and enter a filename for the new macro file.
2. The system automatically adds a “.rcd” extension to the filename.

Macros
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10 Co-Localization Staining Detection
The Nuance system’s Co-localization tool is used to find overlapping layers in a dataset and perform
multi-analyte immunohistochemical analysis in brightfield and fluorescence. This tool can accurately
evaluate nuclear or non-nuclear positivity for multiple antigens and can detect and quantitate colocalization of up to ten markers. It is designed for analyzing and quantitating molecular markers and
can be used to determine the amounts of co-localization of multiple markers.
The Nuance system resolves the absorption pattern of co-localized chromogens and generates
quantitative images of the individual analytes. The Nuance system also separates fluorophores from
each other and from ubiquitous autofluorescence background, allowing more sensitive and quantitative
studies.

10.1 Opening a Dataset for Co-localization Analysis
1. Open the cube or result set you want to analyze. (The dataset used in this example is included
with the software and can be found at C:\Nuance Data\Images\Sample Data\ER_PR
Datasets\Breast Cancer_ER_PR_OD.im3.)
2. If you opened a cube, then open a tested and reliable spectral library or protocol and unmix the
cube into its component images. (The co-localization tool will only open a result set. It cannot
open an image cube that has not been unmixed.)
3. Click the Co-localization button on the toolbar (or select Tools > Co-localization).
4. The result set opens in the Co-localization dialog box.
a. The ‘Unmixed_Composite’ image from the result set displays at the upper-right. The image
displays with the default settings, or with the display settings defined in the co-localization
settings, if a settings file is loaded. (See Saving and Loading Co-localization Settings 95 .)
b. The spectral Components of the result set are listed at the upper-left. The Spectral Names
are taken directly from the library and cannot be changed here. The names in the Marker
column are ‘nicknames’ for the components. Marker names derive from the spectral names
and can be changed to something more descriptive. For example, you might change the
‘Red’ nickname to ‘Fast Red.’ Also, if a co-localization settings file is loaded, its name
displays in the Settings box.
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Figure 48: Dataset in the Co-localization Tool

c. The Settings tab lists thresholding values for each marker. These are calculated
automatically upon loading the result set. If you loaded a co-localization settings file
containing saved threshold values, the thresholds from the settings file will be used instead.
Use the Statistics tab to configure the display of the co-localization percentages, pixel
counts, and component statistics. The Display tab is similar to the Display Control tool
that lets you adjust image brightness, contrast, scaling, etc.
d. Use the Co-localization options at the lower-left to select which markers to use for colocalization detection and which to use for the counterstain. Visibility options let you adjust
the co-localization mask.
e. As you select markers and counterstains, statistics are calculated and displayed in the
Statistics area. Statistics include the percent of co-localization for the entire image as well
as individual markers, the positivity of markers within other markers, and component
statistics.
f.

Use the Copy and/or Export buttons when you are ready to save co-localization images and
statistics. Images can be exported as JPG or TIFF images, and data can be exported as
TXT files. See also Copying Images and Data 99 .

10.2 Adjusting Threshold Mask Values
The Co-localization tool is pixel-based, and thresholding determines which pixels are considered
positive for each component. Upon loading a result set, the tool autocalculates the optimum threshold
value for each marker. However, if a co-localization settings file for the dataset is loaded, the tool will use
the thresholds in the settings file.
Because thresholds must be set properly for accurate results, you should visually check the threshold of
each marker, as follows:
1. Turn OFF Visibility for all but one of the components listed at the top-left. (For the example in
the Co-localization Tool 92 figure, the DAB and HEMA components were turned OFF first.)
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2. Now turn the threshold mask for the visible marker ON and OFF a few times to see the pixels
that are represented by its mask.
3. Use the threshold slider or scroll box to adjust the threshold of the marker, such that all pixels
of individual nuclei or membranes are represented by the mask.
Setting a threshold requires operator judgment, since this setting determines which intensities
are included in the analysis. Each threshold mask should cover only the cells for its component,
and individual nuclei or membranes should be identified in the mask as individual constituents.
This ensures an accurate measure of the desired pixels in each channel. If threshold pixels are
present between nuclei or between membranes, this usually means the threshold is set too low.
4. Repeat this procedure for the other marker(s), paying close attention to the cells and pixels that
contain only the particular chromogen for that marker.
5. Also, note the Minimum Pixels value. This restricts the threshold mask to groups of pixels that
are larger than this value. For this sample dataset, the default value of 20 was too large; there
are smaller groups of pixels that should be included. Therefore, this value was changed to 10 for
all three component markers.

10.3 Selecting Markers for Co-localization
The dataset’s components are listed in two columns at the lower-left, in the Co-localization group. As
you select markers and counterstains, you will see the Statistics area reflect the calculated
percentages. See figure below.
1. In the Markers for Co-localization column on the left, select the markers for which you want to
see overlap (co-localization) and their positivity percentages. (In this example, Red and DAB are
selected as co-localization markers.)
2. In the Denominator(Counterstain) column, select the marker to use as the counterstain. If you
want to see co-localization of markers throughout the entire dataset, and not just within a
particular counterstain, then you would select All Image Pixels. (In this example, Hema was
selected as the counterstain.)
3. The Co-loc. Label name defaults to ‘Overlap’ and can be changed if desired. This is the name
given to the co-localization values when they are displayed in the component statistics and
when the data is exported.
4. Clicking the Show Co-loc. button quickly turns off all threshold masks in the component image
and turns on only the co-localization mask. Clicking the Show All button quickly turns on all
threshold masks that participate in the overlap as well as the co-localization mask.
5. You can select any Mask Color from the pull down color menu.
6. The Visibility eye turns the co-localization mask visibility on or off. In the figure below, all
threshold masks (except ‘Autofluor’) and co-localization masks are turned on.

94

Nuance Multispectral Imaging System

Figure 49: Co-localization & positivity percentages

10.4 Saving and Loading Co-localization Settings
When you want to save the current co-localization display and configuration settings, save a Colocalization Settings file. This file will include Component settings, Thresholding settings and values,
Co-localization Marker selections, and Statistics and Display options. If a settings file is loaded
already, you can overwrite the existing file or save a new one. (Co-localization settings are not saved
in Nuance Protocols.)
1. Leave the Co-localization window open and select File > Save Co-localization from the main
menu.
2. Name the settings file and click Save. You can now open and run co-localization detection on
any number of compatible result sets using this settings file.

Loading Co-localization Settings
You can load a saved settings file before or after opening a dataset in the Co-localization tool.
1. Select File > Open Co-localization from the main menu.
2. Select the settings file you want to load and click Open.
3. The selected settings file displays in the Settings box at the top of the Co-localization tool.
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Co-localization settings must be compatible:
Before the Co-localization tool loads a settings file, it checks to see if the settings file is compatible
with the result set (if one is loaded). Both must have the same number of spectra.
If the result set does not have the same number of spectra as the settings file, you will be notified
that “The current result set is incompatible with the selected co-localization settings.” Load a
matching settings file or result set, or create a new settings file for the current result set.
However, if the number of spectra in the result set matches the number of spectra in the settings file
you want to load, the tool is able to load the file even if its spectra are not identical. In this case, you
will have to use the spectra in the result set. This will reset the component names to the spectra
names, but their nicknames will remain unchanged.

10.5 Interpreting the Statistics
Note the following in the Statistics area:

Figure 50: Co-localization Statistics Display

a. The percent of Red and DAB Co-localization in this dataset is 20.64%. This means that out of
all the Hematoxylin counterstain signal (selected as the Denominator), 20.64% of those pixels
have Red and DAB co-localization. The number of pixels within the Hematoxylin counterstain
that are also co-localized with the Red and DAB markers is 93,535.
b. The percent positivity of Red labeled pixels within the Hematoxylin counterstain is 23.47%
(106,362 pixels).
c. The percent positivity of DAB labeled pixels within the Hematoxylin counterstain is 44.01%
(199,413 pixels).
d. Of the 203,943 DAB labeled pixels, 46.33% of them are also Red positive.
e. Of the 114,673 Red labeled pixels, 82.39% of them are also DAB positive
f.
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The Component Statistics rows display for all components that you selected on the Statistics
tab (at the left in the Co-localization dialog box).
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Every component has an Overlap row that displays the area and signal statistics of the
overlap (co-localization) for each component.
There is also a Full Image ROI for every component. If there are no ROIs drawn on the
image, the default ROI is the full image. If you draw ROIs (see Drawing Regions of Interest 97
), a new row will be added to the Component Statistics area for each ROI. The system
automatically numbers and labels ROI’s to distinguish them in the image window and in the
statistics table.

10.6 Customizing the Statistics Display
Click the Statistics tab. Here you can turn on or off the Percentage and Pixel Count displays for each
statistical category. You can also select to display or hide the Component Statistics. This figure shows
all of the statistics options turned on.

Figure 51: Co-localization Statistics

10.7 Drawing Regions of Interest
If you want to select a specific area of the image to process, click an ROI button at the left of the image
and use the mouse to click-draw region(s) of interest. Note that once an ROI is added to the image, the
All Image Pixels option in the Denominator (Counterstain) list becomes All ROI Pixels. The
statistics are updated automatically as you draw and modify ROIs. Additional buttons let you erase an
ROI and clear all of the ROIs. You can also zoom and pan the image.
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Cloning, Moving, Deleting ROIs
Right-click on the region within the image and select the desired action from the drop down menu.

Applying Regions from a Saved ROI File
You can apply regions from a saved ROI file to the composite image. (Working with regions is
described in more detail in the Quantifying Results 75 topic.) Right-click on the image and choose
Load User Regions from the drop down menu. Select an ROI file from the dialog box.

Saving Regions
To save the current regions, right-click on the composite image and choose Save User Regions.
Enter an ROI file name, select a location, and click Save.

10.8 Customizing the Composite Image Display
Click the Display tab to view the display controls:
To view images in fluorescence or brightfield, use the Composite Coloring Style options. In
general, you want to select the mode under which the original image cube was acquired.
Use the Display Adjustments and Component selectors to choose whether you want to adjust
the display of the whole image or a selected layer.
Use the Brightness and Contrast sliders to adjust the brightness and contrast of the image, or of
the selected layer if Single Layer was selected.
The Min. Max. option maps the minimum value in the image to 0, the maximum value to 255, and
linearly interpolates in between those values. This stretches dark signals so they become visible.
The Clip/Stretch option is the default display scale. It maps the lowest 0.01% of the pixels to 0,
the highest 0.01% to 255, and linearly interpolates in between those values. This prevents a few
bright or saturated pixels from skewing the display.
The Histogram Eq. option maps the pixels so the histogram of the pixels have approximately the
same number of pixels in each bin. This gives the best display of the whole dynamic range of dim
and bright signals.
The Raw option applies no scaling to the data.
The Abundance option scales all pixels in the composite image by the ratio of 255 and the value
of the single brightest pixel among all the components. This usually results in a brighter
composite image.
Regions are numbered according to size, from largest to smallest. Check Show Region Labels
if you want region numbers to appear inside each region.
The Show Markers and Co-localization Masks option lets you quickly turn on or off the mask
settings you selected on the Settings panel.
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10.9 Copying Images and Data
Copying Images
To copy the current image as displayed to the Windows clipboard, click the Copy Image button. Paste
the image into any software program capable of displaying graphic images.

Copying Data
To copy all of the displayed data in tab delimited format to the Windows clipboard, click the Copy Data
button. Paste the data into any spreadsheet program such as Microsoft Excel.

10.10 Exporting Images and Data
Exporting Images
To export the current image as displayed as a JPG or TIFF RGB file, click the Export Image button. In
the Choose RGB File dialog box, enter a file name and location for the image and click Save.

Exporting Data
To export all displayed data in tab delimited format as a TXT file, click the Export Data button. In the
Choose Measurement File dialog box, enter a file name and location for the file and click Save.
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11 FAQs
What is the CCD sensor active area dimensions and the individual pixel size?
The active light sensitive area of the CCD is 1392 pixels in the horizontal direction and 1040
pixels in the vertical direction. Each pixel is 6.45 µm square.

What is a C-mount adapter and why do I need a 1x version for my microscope?
Most microscopes can be equipped with an industry standard 1x (no magnification or
demagnification) camera adapter with a male C-mount on one side and a microscope cameratube connector (usually called a 'dovetail' because the cross-section of the connector is beveled)
on the other side.
Since the Nuance imaging module contains a 0.65x demagnifying optical coupler and 2/3-inch
CCD, a 1x adapter is needed on the microscope camera port in order to prevent vignettingdarkening or loss of part of the image in the corners and sides.
Nuance systems are designed with a female C-mount to attach ONLY to a male C-mount
microscope camera port. If you have an older microscope with an F-mount or ENG mount,
contact your microscope reseller to see if your microscope can be upgraded to accept a Cmount camera. Because of the Nuance imaging module's internal 0.65x optical system, you
must utilize a 1x C-mount camera adapter on your microscope.

Can I use non-apochromatic or achromatic lenses for brightfield microscopy using the
Nuance system?
When using relatively inexpensive achromatic objectives, images acquired below 450 nm (the
deep blue part of the visible spectrum) may suffer from a loss of sharpness and/or a shift in
focus. We have not found that there is a dramatic improvement in brightfield unmixing results
when using expensive apochromatic objectives. We recommend trying a variety of objectives that
you own, and determining your own level of satisfaction with the processed images.

Can I use my own C-mount lenses on a Nuance system for macro-imaging applications?
The Nuance multispectral imaging system performs best with its own high-quality lenses. While
there are many C-mount lenses on the market, you must beware of those designed for simple
color (RGB) imaging. They are often not designed for high-quality multispectral imaging. Contact
PerkinElmer or your authorized PerkinElmer distributor to discuss lens selection for your
wavelength range of interest.
PerkinElmer sells a Nikon 60 mm micro-Nikkor lens with an optimized F-to-C mount adapter
(with field-flattening lens element), as well as PerkinElmer-labeled lenses for visible imaging and
PerkinElmer-labeled lenses for NIR imaging. Other lenses may also be usable. We have not
found other third-party lenses that produce an undistorted image with respect to flatness of field,
and also function appropriately in the spectral realm. PerkinElmer recommends trying a variety of
lenses to determine which is acceptable in your particular application.

Will high numerical aperture (NA) lenses (e.g. 40x 1.4 NA) work better on a Nuance
system?
Yes, especially if the light level is low and the lens is fully color-corrected (apochromatic). The
numerical aperture of a lens defines its ability to capture light (i.e., the higher the NA, the greater
the ability to capture light). For dimly emitting fluorescence, one goal is to capture the maximum
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amount of light. When more light is able to travel through the lens, shorter exposure times and
faster acquisition times can be achieved.
The ideal combination is a high N.A. lens, at the lowest magnification possible for the task at
hand. The rationale for lower magnification is due to the decreased brightness per object as the
magnification increases.

What can you tell me about the polarization sensitivity of the Nuance optical system?
The Nuance optical system incorporates a linear polarizer in the light path when the tunable
wavelength element is in place (the “MSI” setting; not the “Mono” setting), which can conflict with
other polarizing elements in the microscope or lens system, greatly reducing the light
throughput.
Do not use a linear polarizer with the Nuance system unless necessary. If you must use one (for
DIC imaging, for example), make sure that the last polarizer in the microscope is aligned with
that of the Nuance for maximum light throughput.

Why do I need to use a longpass emission filter with the Nuance system to do
fluorescence imaging?
Modern fluorescence microscopes incorporate two narrow filters, as well as a dichroic mirror.
This combination is selected to provide narrow wavelength excitation light, and then exclude the
majority of the excitation light from the fluorescence emission. The dichroic mirror is matched to
both the excitation filter and the emission filter to improve the performance of each.
For the Nuance system, it is desirable to see as much of the emission spectrum as possible,
not just what might be the peak transmission wavelength. So, it is advantageous if the
narrowband emission filter is replaced with a longpass filter.
This effectively suppresses the excitation light, but passes a much larger percentage of the
emitted light, including the autofluorescence. The Nuance system then can not only remove the
autofluorescence, but also identify multiple fluorescence emissions. If a longpass emission filter
is not used, the excitation light may bleed through the Nuance tunable filter system and cause
artifacts and poor performance.

Why can't I just use my standard (emission) filters, collect the images at each of the
peak transmission wavelengths, and then run the images through your software? Won't I
get more light, especially at wavelengths were I am dealing with dim samples?
The Nuance system doesn't just take images at the so-called peak emission wavelengths. The
predicted (or published) peak emission wavelengths may vary according to other variables,
including chemistry. In many situations, such as autofluorescence, the peaks of two signals may
be very close to one another, but their spectral curves may differ in shape. Simply having more
light with a limited number of wavelengths, in the case of overlapping signals, won't help.

I am about to install an upgrade to the Nuance software onto my computer. Should I
take any precautions in case I want to go back to the previous version of the software?
In general, updating the Nuance software can be accomplished by simply running the installer for
the new version. In some cases, usually with legacy or Beta (test) software, you must remove
the old version of the software before running the installer for the new version of the software. To
install the new version of the Nuance software, see the separate "System Setup & Installation”
guide.
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12 Troubleshooting
At high magnifications, I sometimes see a texture in my images, similar to what one
might see looking through a shower curtain. This appearance could also be described
as an “orange peel” texture. What is this phenomenon?
At 60x or higher magnifications, shadows from the multi-layer liquid crystal tunable filter (LCTF)
in the light path may become visible. You can effectively eliminate it by white-cube correcting in
brightfield imaging. PerkinElmer presently is working on methods to automatically correct for this
effect.

How can I verify that the Nuance Imaging System is working correctly?
To verify that the Nuance imaging system is working correctly, take some images of a brightfield
stained microscope slide and a fluorescence microscope slide. Dual-stained brightfield
microscope slides and quantum dots show up well. You can use these acquired images to test
the Nuance software's unmixing feature.

When doing brightfield microscopy, the background appears yellowish. How do I get
white backgrounds?
Turn up the light all the way and use a Neutral Density (ND) filter to bring exposure times to
around 30 to 50 ms. A blue-green correction filter, as used for color photography, is
recommended for tungsten-halogen illumination systems. This filter corrects for the red-biased
light that our eyes—but not digital imaging systems— automatically correct for.

When unmixing a cube, how can I get the background signal to disappear in the
unmixed composite image?
For brightfield image cubes, unmix into white any signal (such as the background) you want to
hide. For fluorescence images, unmix into black the signal you want to hide.

How do I go back to a previous version of the software?
If you created a Restore Point before you installed a new version of the Nuance software,
returning to the old version of the software merely involves restoring your computer to the earlier
time, before you installed the latest version of the software. If you did not create a Restore Point,
you should remove the new version of the Nuance software using “Add/Remove Programs” and
then install the old software from the original CD-ROM or downloaded installation file.

What should I do if the camera or hardware is not detected?
Power OFF the computer and disconnect the Nuance module's power cable. Next, unplug the
Nuance's USB cable from the computer. Reboot the computer, and then reconnect the Nuance
module's power cable. After both systems finish rebooting, plug the USB cable back into a USB
port, preferably a different port than last time.
If this does not resolve the problem, please contact PerkinElmer at global.
techsupport@perkinelmer.com.

Why does the image look different on the screen than through the eyepiece?
The Enhance Contrast option may be turned on in the Display Control tab, which will affect the
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view of the image cube. Also, the Wavelength to RGB Map may be switched from the default
Visual RGB to Equal RGB. Visual RGB maps the cube wavelengths to mimic the wavelength
response of the human eye; Equal RGB maps the wavelengths equally. Refer to Adjusting a
Cube's RGB Mapping 84 .
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13 System Specifications & Dimensions
The specifications given in the following topics represent typical Nuance multispectral imaging systems
as of September 2010 and are subject to change.

Liquid Crystal Tunable Filter
Parameter

Specification

Wavelength tuning range

VX/FX: 420 - 720 nm
EX: 450 - 950 nm

Bandwidth flexibility, FWHM

VX: 7, 10, or 20 nm
FX: ~20 and ~40 nm (software selectable)
EX: ~20 and ~40 nm (software selectable)

Wavelength accuracy

Bandwidth/8

Typical acquisition time

Approximately 5 seconds

Note: Acquisition time depends on a number of factors, including the bandw idth of the Nuance system and the
amount of light emitted, reflecting off, or transmitted through the specimen at each w avelength of interest.
The Nuance system is designed to dw ell at individual w avelengths if it determines that more light is needed
to produce images w ith adequate spatial and spectral detail. The system is not limited by a need to acquire
images using identical exposure times at each w avelength. The benchmark performance standard is the
acquisition of a 16-w avelength stack from a typical brightfield specimen w ithin 5 seconds using 8-bit mode
and 2x2 pixel binning, light permitting.
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Parameter

Specification

Cooling

TE cooled to 8 °C

Image sensor format

2/3" diagonal

Effective pixels

1392 x 1040 pixels

Image sensor pixel count

1.4 megapixels

Optical interface

C-mount (female) 1X

Mounting method

US ¼-20 tripod mount

Optical input (maximum)

500 mW/cm2

Nuance Multispectral Imaging System

Imaging Module
Parameter

Specification

Dimensions

3 ½" high x 5 ¼" wide x 8 ¾" long

Weight2

4 lbs 10 oz (2 kg)

Center of C-mount

1½" from center of C-mount to lower surface with
standard tripod mount

Filter sets 3

See the Filter Selection Guide 107

2

Does not include workstation computer.

3

Filter sets must be purchased separately. Contact PerkinElmer or your authorized local
distributor for pricing and availability.

Environmental
Parameter

Specification

Operating environment

Indoor

Operating temperature

15 °C to 40 °C

Operating humidity

65% maximum, non-condensing

Operating altitude (maximum)

2000 meters

Storage temperature

-10 °C to 55 °C

Storage humidity

100% maximum, non-condensing

Pollution degree

2

Utilities
Parameter

Specification

Electrical power

+5V Universal4

4

A set of wall outlet plugs may be provided for common US and International wall outlet types.
The electrical supply itself is a switching-type for 100-230 VAC.
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Computer System Requirements
Parameter

Specification

Processor

3.0 GHz or higher Intel™ Pentium™ 4 class or Intel
Centrino™

RAM (minimum)

2 GB

Hard disk drive (minimum)

160 GB

CD-ROM drive

writable CD-ROM drive

Operating system

Included:

Microsoft® Windows 7 (English Language
Version) 32-bit operating system
(64-bit OS is supported as well; the Nuance
3 software will run as a 32-bit application)

Supported: Windows® XP Professional (US)
Display (minimum)

24-bit color, 1280 by 1024 pixels

Computer interface

One available USB 2.0 interface

Using Third-Party Computers with the Nuance Software
If using your own computer (one not purchased from PerkinElmer) to run the Nuance system or to
process Nuance data offline, consider the following parameters for optimum performance:
The faster the computer CPU, the faster certain operations in software will be accomplished.
More hard drive space allows more and larger datasets to be acquired and stored.
At least 2 GB of RAM is recommended for data processing.
A USB 2.0 port is required (if you want to connect to the Nuance system).
The US English versions of Windows® 7 and Windows XP Professional are the only supported
operating systems.
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14 Filter Selection Guide
Color denotes usable longpass filters, X denotes the recommended longpass filter.
Fluorophore
Nuance Longpass Emission Filters
Name

Excitation (nm) Emission (nm)

420 LP

475 LP

515 LP

590 LP

610 LP

525 nm QDot®

<500

525

X

545 nm QDot®

<520

545

X

565 nm QDot®

<540

565

X

605 nm QDot®

<580

605

X

655 mn QDot®

<620

655

705 nm QDot®

<650

705

X

800 nm QDot®

<750

800

X

Alexa Fluor® 350

347

442

Alexa Fluor® 488

492

520

Alexa Fluor® 500

500

530

Alexa Fluor® 514

514

545

Alexa Fluor® 532

532

554

Alexa Fluor® 546

556

573

X

Alexa Fluor® 555

555

580

X

Alexa Fluor® 568

577

603

X

Alexa Fluor® 594

590

618

X

Alexa Fluor® 610

612

628

X

Alexa Fluor® 633

632

650

X

Alexa Fluor® 647

647

666

X

DAPI

358

460

X

Hoecsht

352

450

X

AMCA

350

430

X

Cy 2™

498

506

Cy 3™

554

568

Cy 5™

649

666

X

Cy 5.5™

675

695

X

GFP

475

509

FITC

490

525

X

eGFP

498

515

X

Y FP

520

532

X

Rhodamine

550

573

X

TRITC

555

580

X

RFP (dsRed)

558

583

X

Texas Red

595

615

SY TOX® Blue

445

470

SY TOX® Green

505

532

SY TOX® Orange

570

547

X

X

X
X

X
X
X
X

QDot, Alexa Fluor, and SY TOX are registered trademarks of Inv itrogen, Inc.
Cy anine dy e (Cy 2, Cy 3, Cy 5 and Cy 5.5) is a trademark of Amersham Biosciences.
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15 MetaMorph Support
Support for MetaMorph in Nuance lets MetaMorph users perform their scripted work using PerkinElmer’s
Nuance camera with or without the Nuance software. Note the following examples:
1. Use MetaMorph alone to operate the microscope and the PerkinElmer Nuance camera (Nuance
software is not running).
When not using the Nuance software, the camera’s tunable filter can be moved out of the
optical path (by sliding the thumbswitch on the front of the camera to the MONO position).
The PerkinElmer Nuance camera is used just like other scientific digital cameras. You can
select 8-bit or 12-bit acquisition mode by choosing Acquire > Select Acquisition Channel
from the menu in MetaMorph. For most fluorescence imaging applications, the 12-bit
acquisition mode will generate better quality images.
The MetaMorph software controls the microscope (can move the stage position, autofocus
the image, etc.) and uses the Nuance camera to acquire fluorescence images.
You can adjust the camera gain, offset, and cooler function from within MetaMorph. Choose
Acquire > Settings from the menu. Click on the Special tab. Adjust the Gain and Offset
values as needed for your application. The gain and offset values selected here are specific
to MetaMorph; they will not affect the Nuance software/camera interaction. Note also that
the Cooler can be turned off, but this can degrade image quality. Leave the cooler on.
2. Use MetaMorph and Nuance software interactively. Both applications share the PerkinElmer
Nuance camera.
Mostly used for multispectral imaging and unmixing using MetaMorph journals.
MetaMorph software has access to the camera via the journal system. For example,
MetaMorph can start a live image stream, move the microscope stage to the desired
location, autofocus the image, and freeze the live stream. MetaMorph can then give control
of the camera to the Nuance software to acquire an image or a multispectral image cube.
Acquired images can be processed in MetaMorph, and cubes can be unmixed in Nuance
prior to further processing in MetaMorph.
The Nuance journal taskbar is accessed by choosing Journal > Taskbar > Load Taskbar
from the menu. The figure below shows an example of the Nuance taskbar. Instructions on
how to install the journals are provided later in this topic.
Use the journals on the Nuance taskbar to perform actions such as Start Live (start the live
Nuance image), Load Protocol (load a Nuance protocol), and Take Cube (acquire a
multispectral image cube). You can also use the Nuance taskbar journals as individual
commands in your own MetaMorph journals: Choose Journal > Start Recording and click
the taskbar commands in the order you want them to occur. (Remember to stop recording
when finished.) Finally, you can open and examine the Nuance journals from within the
Journal Editor to help you customize your own MetaMorph journals.
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Figure 52: Nuance Journal Taskb ar

3. Use Nuance software as usual (MetaMorph software is not running). Installation of MetaMorph
Support in the Nuance software does not effect its independent operation of the PerkinElmer
Nuance camera.

15.1 Installing and Configuring MetaMorph
Software Requirements
Requires MetaMorph 7.5.4 or later
Requires Nuance 2.8 or later
Both Nuance and Metamorph must be run as an administrator.

Purchasing the Software
PerkinElmer is an authorized distributor of MetaMorph software: Nuance customers who would
like to purchase the MetaMorph software with Nuance support can do so directly through
PerkinElmer.
Existing MetaMorph customers who would like to upgrade to Nuance support may contact either
Molecular Devices or PerkinElmer to purchase the required Nuance drivers.

Installing and Configuring MetaMorph
1. Before installing the Nuance software, make sure the MetaMorph software is installed. If an
earlier version of MetaMorph is installed, obtain and install the necessary updates to achieve
version 7.5.4.
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2. When installation (and any necessary updates) is complete, open the Meta Imaging Series
Administrator tool from the MetaMorph application group on the Windows desktop.
3. Click the Drop-ins/Toolbars button.

Figure 53: Meta Imaging Series Administrator

4. Make sure a check mark appears next to the acquire and applink drop-ins.

Figure 54: Drop-ins/Toolb ars

5. Click OK to save the changes.
6. Now click the Configure Hardware button.
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Figure 55: Meta Imaging Series Administrator

7. Click the Configure Acquisition button.

Figure 56: Configure Hardware

8. The Nuance driver must be moved to the list of installed drivers in order to enable the MetaMorph
support option in the Nuance software installation wizard. Proceed as follows: In the Configure
Acquisition dialog box, select CRi Nuance Demonstration in the Available Drivers list and
Add>> them to the Installed Drivers list.
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Figure 57: Configure Acquisition

9. Click OK to save the changes.

15.2 Installing Nuance with MetaMorph Support
1. Make sure the Nuance camera is turned off and disconnected from the computer. Also, remove
the MetaMorph software license key from the computer’s USB port.
2. Insert the Nuance software install CD. If the Installation Wizard does not start automatically,
open a My Computer window and explore the CD drive. Double-click the Install.exe file to start
the wizard.
3. Follow the wizard prompts to install the software. At the MetaMorph Support dialog, select “I
wish to install MetaMorph support”.

Figure 58: CRi Nuance Installer – MetaMorph Support
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4. Click Next to proceed through the rest of the installer.
5. After installing the software, reconnect the Nuance camera to a USB port. Then re-connect the
camera to power.
6. Open the Nuance software. Verify that the camera has initialized properly by checking for a live
image in the Live Image window.
7. Close the Nuance software, but leave the camera ON.

15.3 Import the Journal Suite for MetaMorph
1. Plug the MetaMorph license key into a USB port on the computer. Launch the MetaMorph
software.
2. If no camera is connected, MetaMorph will alert you that the software may not be fully
functional. Accept these messages to continue with launching the software anyway.
3. Select Journal > Import Journal Suite from the MetaMorph main menu.
4. Click the Select Journal Suite button.

Figure 59: Select Journal Suite to Import

5. Navigate to C:\MM\CRi\Nuance. Look for the NuanceSupport.jzp file. If the file is not found,
look in C:\Program Files\PerkinElmer\Nuance x.y.z\MetaMorph support (where x.y.z. is
the latest installation of Nuance).
6. Select the NuanceSupport.jzp file and click Open.
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Figure 60: Select Import Suite File

7. NuanceSupport.jzp should appear in the Files to be imported list. Click the Select Import
Location button.

Figure 61: Select Import Location

8. Navigate to the location where your MetaMorph journal files are stored. Suggestion: ...
\app\mmproc within your MetaMorph folder. Select the journals folder.
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Figure 62: Browse for a Folder

9. Click OK to save and return to the Import Journal Suite dialog.

Figure 63: Import Journal Suite

10. Click the Import button to import and extract the NuanceSupport.jzp file.
11. The individual journal files will be extracted to the selected folder.
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Figure 64: Extracted Journal Files

15.4 Troubleshooting
Although MetaMorph offers support for other PerkinElmer products such as the Varispec™ tunable filter,
do not enable this feature. Doing so will cause conflicts between the Metamorph software and the
Nuance software. If this is enabled already, you should disconnect MetaMorph’s Varispec support.
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16 Koehler Aligning the Microscope
Professor August Koehler developed a method in 1893, now commonly referred to as “Koehler”
illumination, to precisely control the light path and the illuminating beam upon a microscope specimen.
You can get the best possible image from nearly all types of optical microscopy, whether brightfield,
fluorescence, DIC, phase contrast, or polarization microscopy by using Koehler illumination.
Even a slightly misaligned microscope can exhibit symptoms such as uneven illumination, glare, or
internal reflections. Decreased spectral resolution often results because of color fringing and poor
contrast. Aligning your microscope is important for obtaining the best results from the Nuance system.
Follow the directions below to achieve Koehler illumination and the best possible image quality from your
microscope.
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17 About Legacy Hardware
This topic discusses operation-specific aspects of legacy Nuance multispectral imaging system
hardware.

Nuance Models with a FireWire Interface
Previous models of the Nuance system incorporated a different enclosure design and used the
FireWire™ interface, as well as an RS-232 serial connector, instead of the present USB interface.
The power transformers also differ between the present and legacy hardware and ARE NOT
INTERCHANGEABLE between present and legacy systems. Contact PerkinElmer if you need a
copy of the previous User's Manual specific to the hardware of these older models.
At the time of the release of this User's Manual, all current versions of Nuance software will properly
operate legacy hardware. Therefore, you may refer to this User's Manual for basic instructions on
using the most recent software with legacy hardware.

Setup and Operation
See the Nuance User's Manual, revision 1.1 for instructions on setting up Nuance systems hardware
with the FireWire™ interface.
USB Copy Protection Keys supplied with version 1.30 of the Nuance software or later will run older
versions of the Nuance hardware. USB Copy Protection Keys supplied for software versions 1.2.x or
earlier will only enable pre-1.30 software. Therefore, newer dongles work with older software but not
vice versa. Contact PerkinElmer if you have older (pre-1.30) software and wish to upgrade to the
most recent software.

Specifications
See the Nuance User's Manual, revision 1.1 for the most recent table of specifications for Nuance
systems with the FireWire interface.

Mechanical Dimensions
See the Nuance User's Manual, revision 1.1 for the most recent mechanical drawings of the
enclosure for Nuance systems with the FireWire interface.

Miscellaneous
Unlike present Nuance enclosures, legacy enclosures do not allow the movement of the liquid crystal
tuning element out of the light path. Legacy Nuance systems hardware require a different hardwarespecific driver to enable the camera to function properly. The installer will be named accordingly.
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18 Windows User Management
In most instances, the computer used to run the Nuance system will be shared by multiple users. Each
user will have his or her own Nuance protocols, cubes, spectral libraries, and other documents and files
associated with his or her work with the Nuance system.
Each system user should be assigned a personal Windows user account on the computer. There should
be one Computer administrator account for (in most cases) the lab director or similar person. All other
users should be given Standard accounts that should be password protected for increased security.
Users should be instructed to save their work within their own My Documents directories, which are
private and cannot be accessed by other Standard users. This prevents other users from accessing
Nuance files or documents that belong to their peers (i.e., other Standard users).
The following table contains the required steps for password protecting the Computer administrator
account and setting up Standard accounts and passwords for other users.
Action

User Accounts Dialog Box

The computer is set up at PerkinElmer with one Computer administrator account named “Nuance.”
This default account is not password protected. This lets you start up and use the computer without
having to log on or enter a password.
Create a password for the Nuance user account. Then, created Standard user accounts with
passwords for each of your users.
Password protect the Nuance
administrator account:
1. Click the Start button, then
select Control Panel >
User Accounts.
2. Under Make changes to
your user account, make
sure the Nuance
Administrator user is visible
(as shown in this example).
3. Click on Create a
password for your
account.
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4. Type and retype the
password as instructed.
5. You may also enter a
password hint to use in
case you need help later
remembering the
password.
6. Click Create Password.
7. A password is now required
to log on to the computer
as the Nuance
administrator.
Create Standard user
accounts:
1. Return to the top level
Control Panel > User
Accounts dialog box. If you
don't see the Create a
new account option, click
in the search box at the top
of the window, type create,
and press Enter.
2. Select Create standard
user account.

3. Name the new account:
You may enter a full name
(e.g., John Smith) or an
abbreviation (e.g., jsmith).
4. Select Standard User and
click Create Account.
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5. You will notice the new
user added to the list of
accounts.
6. Click on the icon for the
new user’s account to
select it.

7. Create an initial password
by clicking Create a
password.

8. Type and retype a very
generic password for the
user, such as “password."
9. Click Create Password.
10. The user’s Standard
account is now password
protected. Only this user
will have access to
documents and files saved
in his or her My
Documents directory.
Similarly, this user has no
access to the My
Documents directories of
other users.
11. Repeat this procedure for
each user account you
need to create.
12. Exit the User Accounts
Control Panel when
finished.
13. When you log off, or the
next time the computer is
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turned on, the login screen
appears. Users should be
instructed to select their
own name and enter their
initial password to log on.
After logging in, users
should access the User
Accounts Control Panel
(as described above) and
select a more personal and
secure password.
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19 Software EULA
The following is an agreement (the "Agreement") between you and Cambridge Research & Instrumentation
Inc., 35-B Cabot Road, Woburn, MA 01801 ("CRI") for software known as either Maestro or Nuance, and its
accompanying documentation (collectively, the "Software"). By installing and/or using the Software, you agree
to the following terms and conditions. If you do not agree to all of the terms and conditions in this Agreement,
you may not install or use the Software.
1.
Single Use License. The Software is licensed to you and not sold. Subject to the terms and
conditions of this Agreement, CRI hereby grants to you a restricted, non-exclusive, non-transferable, nonassignable, non-sublicensable and revocable license to use, for your internal purposes only, the executable
code version of the Software and the accompanying documentation in hard copy or electronic format. CRI
RESERVES ALL RIGHTS NOT EXPRESSLY GRANTED BY THIS AGREEMENT.
2.
Specific Restrictions. You may use the Software only on a single computer at a time. You may not
use the Software on more than one computer or computer terminal at the same time, nor allow access to the
Software from one computer to another over a network, the Internet or by any other means. You may make only
one (1) copy of the Software, solely for backup purposes. You may not decompile, reverse engineer,
disassemble, alter, modify, translate, adapt, decipher, or determine the source code or create derivative works
of, the Software. The Software may contain a software keying feature requiring you to register it with CRI or its
agent, when it is installed on the target machine, and to obtain at that time a unique authorization key for that
machine.
3.
Ownership of Software. CRI and/or its suppliers own all right, title and interest, including all
copyrights, in and to the Software. The Software contains confidential information and trade secrets of CRI.
You (i) acknowledge, and agree not to contest, CRI's rights in the Software; (ii) agree not to disclose to anyone,
or allow anyone access to, the Software; and (iii) agree not to disclose any confidential information of CRI
regarding the Software or that is otherwise disclosed to you in connection with this Agreement.
4.
Transfer Restrictions. The Software is licensed only to you. The Software may not be transferred to
anyone without the prior written consent of CRI. The terms and conditions of this Agreement shall bind any
CRI-authorized transferee of the Software. You may not transfer, assign, rent, lease, lend, sell, grant a security
interest in, sublicense or otherwise dispose of the Software, on a temporary or permanent basis, except for a
CRI-authorized transfer as stated above.
5.
Termination. The license granted in Section 1 above is effective until terminated. This Agreement is
conditioned upon your continued compliance with the terms and conditions hereof and will terminate
automatically without notice from CRI if you fail to comply with any term or condition of the Agreement.
Furthermore, CRI may terminate this Agreement at any time upon thirty (30) days notice. Upon termination of
this Agreement, you shall immediately destroy all copies of the Software (including all accompanying
documentation) and any other confidential and proprietary information you have received during or in
connection with this Agreement.
6.
Limited Warranty. CRI warrants that the media on which the Software is provided will be free from
defects in materials and faulty workmanship under normal use for a period of ninety (90) days from the date of
delivery. Your exclusive remedy under this Section 6 shall be, at CRI's option, a refund of the price paid for the
Software or replacement of the media on which the Software was provided so long as that media has been
returned to CRI under a CRI-issued return authorization. CRI shall have no responsibility to replace media
damaged by accident, abuse or misapplication.
7.
No Other Warranties. EXCEPT FOR THE LIMITED WARRANTY STATED IMMEDIATELY ABOVE, THE
SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, AND CRI EXPRESSLY DISCLAIMS
ANY AND ALL IMPLIED WARRANTIES, INCLUDING WITHOUT LIMITATION ANY WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD PARTY
RIGHTS. CRI DOES NOT REPRESENT OR WARRANT THAT THE RESULTS OR THE USE OF THE
SOFTWARE WILL BE CORRECT, ACCURATE OR RELIABLE, OR THAT THE SOFTWARE WILL OPERATE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. YOU
ASSUME ALL RISK ASSOCIATED WITH THE USE, RESULTS AND PERFORMANCE OF THE SOFTWARE.
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8.
Limitation of Liability. IN NO EVENT SHALL CRI, ITS AFFILIATES OR SUPPLIERS, OR THEIR
RESPECTIVE EMPLOYEES, OFFICERS OR AGENTS, BE LIABLE FOR ANY DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE SOFTWARE, INCLUDING WITHOUT LIMITATION INCIDENTAL, SPECIAL,
CONSEQUENTIAL, PUNITIVE, EXEMPLARY, INDIRECT OR DIRECT DAMAGES (INCLUDING WITHOUT
LIMITATION DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, RE-RUN TIME, INACCURATE INPUT, WORK
DELAYS, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL DAMAGES OR LOSSES), WHETHER IN
AN ACTION IN CONTRACT, TORT (INCLUDING NEGLIGENCE AND STRICT LIABILITY) OR OTHERWISE, AND
EVEN IF CRI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND REGARDLESS OF
WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE.
9.
U.S. Government End Users. The Software qualifies as commercial computer software for purposes
of the Federal Acquisition Regulations (FAR) §52.227-19 and the Department of Defense Supplement to the
FAR (DFARS) §52.227.7013. If the Software is acquired by a civilian government agency, it is furnished with
only the minimum Restricted Rights provided by FAR 52.227-19. If the Software is acquired by a military
agency, it is furnished with only the minimum Restricted Rights provided by DFARS 52.227-7013(c)(1)(ii).
10.
Miscellaneous. This Agreement contains the entire agreement of the parties with respect to the
subject matter hereof and supersedes any proposal or prior agreement, written or oral, and any other
communications between the parties relating to the subject matter hereof. No modification or waiver of any
provision of this Agreement shall be effective unless in writing and signed by the parties. No delay or failure on
the part of any party in exercising any right under this Agreement shall impair any such right or any remedy of
such party, nor shall it be construed to be a waiver of any continuing breach or default under this Agreement. In
the event any provision of this Agreement is held to be unenforceable, the remaining provisions of this
Agreement will remain in full force and effect. This Agreement shall be governed by the laws of the State of
New York without regard to principles of conflicts of laws. Any disputes relating hereto shall be adjudicated
only in the state or federal courts in New York County, New York State, and you hereby consent to the exclusive
jurisdiction of those courts. This Agreement shall not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded. You may not
assign or otherwise transfer this Agreement or any of your rights or obligations therein without the prior written
consent of CRI. You may not use the Software for any unlawful purpose nor export or re-export the Software
except as authorized by law.
11.

TIFF module.

The TIFF module used is Copyright (c) 1988-1997 Sam Leffler Copyright (c) 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR
OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL,
INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.
12.
Modules covered by LGPL license. This software includes the IconFactory.dll library module, which
uses the Ximian icons. These icons were authored by Novell and are bound by the LGPL license. Source code
is available upon request to CRI at the address below.
13.
Other Modules. This software incorporates the following source code or library modules without
alteration: the Independent JPEG Group’s software; zlib thanks to authors Jean-loup Gailly and Mark Adler;
wxPNG thanks to Contributing Authors (Cosmin Truta, Simon-Pierre Cadieux, Eric S. Raymond, Gilles Vollant,
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Tom Lane, Glenn Randers-Pehrson, Willem van Schaik, John Bowler, Kevin Bracey, Sam Bushell, Magnus
Holmgren, Greg Roelofs, Tom Tanner, Andreas Dilger, Dave Martindale, Guy Eric Schalnat, Paul Schmidt, Tim
Wegner), VIGRA thanks to Ullrich Koethe. This software is distributed with Boost support DLL libraries covered
by the Boost license. They have not been modified by CRI and all rights are reserved by the copyright holder.
Also, it incorporates Anti-Grain Geometry - Version 2.3 Copyright (C) 2002-2005 Maxim Shemanarev
(McSeem), which is supplied under the following terms: Permission to copy, use, modify, sell and distribute
this software is granted provided this copyright notice appears in all copies. This software is provided "as is"
without express or implied warranty, and with no claim as to its suitability for any purpose. Also, it incorporates
the BZIP2 binary library module libbzip2 without alteration, Copyright 1992-2005 Julian Seward. Also, it
incorporates a modified version of Simplex.h Copyright (C) 2010 Botao Jia.
Should you have any question concerning this Agreement, you may contact CRI by writing to CRI, 35-B Cabot
Road, Woburn, MA 01801. You may also call 1-800-383-7924 in the US or +1-781-935-9099 elsewhere.
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Index
-Aabsorption spectrum
11
abundance display
83
abundance scaling
83
achromatic lens
100
acquire mono
52
acquire time sequence
53
acquisition time (typical), specification
104
acquisition wavelength
45
altitude, operating specification
105
area (µm^2)
81
area (pixels)
81
auto exposure
28
autoexpose at current wavelength (mono)
46
autoexpose cube
46
autoexpose target % of dynamic range
28
autofluorescence
12
automatic save options
55
average signal
80
average signal, display box
24

-Bbandwidth, specification
baseline subtract
67
batch processing
72
binning
44, 79
bit depth
27
brightfield cube, acquire
brightness level
83

104

47

c-mount lens
100
c-mount, center of 105
co-localization mask
93
co-localization settings
92
co-localization statistics
96
co-localization tool
92
co-localized chromogens
92
colors, eye’s ability to distinguish
8
component selection
85
composite threshold legend
87
Compute Spectra
manual
63
using RCA
59
contrast level
83
control panels, introduction
24
convert to OD, batch processing
73
cooling (specification)
104
crosshairs
86
CSA mark
19
Cube
autoexpose
46
definition of 14
importing into result sets
66
information, viewing
55
open
58
save
54
save notes with
52
save sample ID with
52
subtracting spectra
67
zooming in/out
26
cube ID
80
cube time stamp
81
current wavelength, specifying
45
cursor x/y coordinates
24
custom display values
84
customizing the spectral display
83

-C-

-D-

calibrating pixel size
29
CCD sensor active area
100
CE test
19
Cleaning
system
21
clip/stretch
83
clone, region
77
c-mount adapter
100

dark current, check
27
dark frame, check
27
denominator(counterstain)
94
Disclaimers
design change
18
reproduction
18
Display
83
brightness and contrast
83
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Display
83
component selection
85
wavelength to RGB map
84
display, co-localization composite
distance calibration
29
distributors in EU
19

-H98

-Eeffective pixels (specification)
104
electromagnetic spectrum
7
emission spectra
11, 13
enhance contrast
84
enhancing display contrast
28
environment, operating specification
environmental specifications
105
error images, viewing
66
error scaling
63
evaluating Nuance software
22
Exposure Time
adjusting
46
custom settings
46
extract image plane
56

-Ffilter selection guide
107
filter setting names
50
filter settings, customizing
50
Filters
choosing
12, 49
excitation and emission
12
FireWire
118
fit offset
60, 64
FLEX imaging
15
flip image check box
27
fluorescence cube, acquire
49
fluorescence, defined
10
frames to average
28
frequently asked questions
100

-Ggain
27
gallery, introduction to

25

105

hardware settings
27
hardware, status
24
help menu
19
hiding a signal
62
hiding measurement columns
81
histogram equalization
83
human perception of light
8
Humidity
operating, specification
105
storage, specification
105

-Iillumination, eye’s response to
8
image cube, definition of 14
image data pages, introduction to
25
image plane, extract
56
image sensor format
104
image sensor pixel count
104
imaging theory
7
immunohistochemical analysis
92
import image
88
intensity legend
88

-Jjournals

108

-KKoehler alignment

117

-LLCTF specifications
104
Legacy Hardware
mechanical dimensions
118
setup and operation
118
specifications
118
light absorbance
9
light, discussion of 7
Line Profiles
67
clone
69
Index
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Line Profiles
67
copy
69
delete
69
move
69
live image stream
44
live overlay
84
longpass emission filter
101
luminescence, defined
10

-M-

open cube
58
optical density
42
optical input (maximum)
104
optical Interface (specification)
orange peel texture
102

104

-P-

macros
89
major axis
81
markers for co-localization
94
max signal
81
maximum exposure
28
measurement pixel unit
28
Measurements
75
appending to a text file
82
copy to clipboard
81
definitions
80
measuring regions
75
save as text
81
MetaMorph support
108
method development
31
Microscope Setup
brightfield
40
fluorescence
41
min. max.
83
minor axis
81
mounting method (specification)
104
multi filter protocols
51
multi filter support
50
multiple images, comparing
69
multispectral analysis, introduction to
14

-Nnarrow bandwidth acquisition
48, 50
neutral density (ND) filter
102
non-apochromatic lens
100
notes, save with cube
52
Nuance EX 17
Nuance FX 17
Nuance imaging module
19
Nuance VX 17
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Panning Images
individual
26
together
27
phosphorescence, defined
10
pixel size, calibration
29
polarization sensitivity
101
pollution degree, specification
105
practice exercise
37
protocol, status
24
Protocols
open
43
save
35

-Rraw cube, acquire
48
raw display
83
real component analysis (RCA)
reference image for flat fielding
reflection
9
Region
clear all
77
region of interest (ROI)
45
region of interest shapes
62
Regions
clone
77
copy all
78
copy measurements
81
delete
77
drag a copy
78
erase part of 77
find automatically
75
ignoring small
80
labels
80
load to an image
79

59
51

Regions
manual draw
76
measurements
80
measuring
75
modify
76
move
77
Save
79
saving measurements
81
threshold segmentation
75
transparency and color
80
regions of interest, co-localization
97
reinitialize hardware
30
resolution, low
30
result set, saving
65
RGB (color) images, acquiring
48
ROI number
80

un-normalized
65
Spectral Library
adding notes to
62
clearing
62
development tips
31
methods for building
31
open
57
save
35
spectrum ID
81
standard deviation
80
status bar, introduction to
24
Stoke’s Shift
11
system dimensions, specification
105
system function test
102
system specifications
104
system weight, specification
105

-S-

-T-

Safety
cautionary statements
17
operator and equipment
17
technical assistance contact
18
sample ID, save with cube
52
saturation mask
84
Save
cube
54
image
54
region
79
unmix results
65
scaling
28
snapshot
52
software license agreement
123
Specimen Stage
height setting
79
Spectra
computing manually
63
import from component image
36
import from composite image
37
import from existing library
36
sampling manually
62
subtracting from cube
67
spectral cube, taking
48
spectral display, customizing
83
Spectral Graph Scale
normalized
65
scale to max
65

Temperature
operating, specification
105
storage, specification
105
third-party computers, using
106
threshold mask values
93
threshold segmentation
75
threshold values
93
thumbnails, introduction to
25
timed acquisition
53
timed sequences
53
toolbar, introduction to
23
total signal
81
troubleshooting
100

-UUL test
19
unmixing images
57
unmixing, tips
57
user defined exposure
28
user management
119
user’s manual, about
18
utility specifications
105

-Vvisible wavelength, discussion of

7
Index
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visible wavelengths

17

-Wwavelength accuracy, specification
104
wavelength and exposure
45
wavelength range, specification
104
Wavelength Selection
manual adjustment
49
wavelength slider, using
45
wavelength to RGB map
84
wavelengths, brightfield cube
47
wavelengths, fluorescence cube
49
window layout, description
25
windows, resizing
26
Workstation Computer
overview of 21
specifications
106

-Xx location

81

-Yy location

81

-Zzooming images
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Warranty
PerkinElmer warrants its Nuance instrument for a period of one (1) year from date of shipment against defects in
material and/or workmanship, provided its installation, application, and maintenance are within specifications.
Normal wearing parts are excluded. This warranty covers only items manufactured by PerkinElmer. PerkinElmer will
correct, by repair or replacement -at its option and its expense- any proved defects in items of its manufacture,
subject to above, provided immediate written notice of such defects is given.
A valid Return Materials Authorization (RMA) must be obtained by contacting PerkinElmer before items may be
returned to the factory. Repair or replacement will be provided F.O.B. (Freight On Board) at PerkinElmer's factory.
The total financial obligation of PerkinElmer, under this warranty, does not exceed the purchase price of the items of
its manufacture as set forth on normal pricing schedules. We will not assume any expense or liability for repairs
made by others without our prior written consent.
This warranty is void and PerkinElmer will be free from all obligations hereunder if the items of its manufacture have
been misused, reprocessed or reused, repaired or modified without our written consent. PerkinElmer assumes no
liability for damages or injuries resulting from the misuse, misapplication, or unauthorized repair or modification of its
equipment.
We assume no liability to users of our equipment or to any other person or persons for special or consequential
damages of any kind and from any cause arising out of or in any way connected with the use of the equipment. All
warranty and post-warranty service is nontransferable from the original shipping address to another without the prior
written consent of PerkinElmer.

TO PLACE AN ORDER OR RECEIVE TECHNICAL ASSISTANCE
PerkinElmer, Inc.
68 Elm Street, Hopkinton, MA, 01748, USA
Phone: 800-762-4000 or +1 203-925-4602
Fax: +1 203-944-4904
Email: global.techsupport@perkinelmer.com

Nuance is a trademark of PerkinElmer, Inc.
Cyanine dye (Cy2, Cy3, Cy5, Cy5.5 and Cy7) is a trademark of Amersham Pharmacia Biosciences UK Limited.
Intel, Centrino, and Pentium are trademarks of Intel Corporation or its subsidiaries in the United States and other
countries.
Alexa Fluor is a trademark of Invitrogen Corporation.
QDot is a trademark of Invitrogen Corporation.
All other trademarks or registered trademarks are the property of their respective owners.
© 2010 - 2012, PerkinElmer, Inc. All rights reserved.
Document Part No. 130765 Rev. 01

